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1 Stereoscopic 3D Editing Workflows

Avid offers a number of ways to edit stereoscopic footage. The stereoscopic workflows build 
upon the current functionality in your Avid editing application. These functions provide essential 
tools in the offline to allow for a solid rhythm and pace when cutting stereoscopic content, along 
with the ability to view and edit either full frame, frame compatible stereoscopic material, or 
standard 2D content.

This guide shows you how to edit stereoscopic projects with Avid video editing systems. 
Stereoscopic editing is currently supported on Avid Media Composer and Avid Symphony.

As with any creative editorial process, there are many ways to achieve the same output. This 
guide provides information on some of the several possible workflows for stereoscopic 
production using Avid products. It augments the product manuals and online help, and does not 
contain all possible functions that can be accomplished by the products. It also assumes that the 
reader already has a good background knowledge of stereoscopy.

Refer to one the following workflows for guidelines on how to edit your stereoscopic media:

• “Feature Film Offline Workflow” on page 3

• “Live Broadcast Workflow” on page 7

• “In-Studio Production Workflow” on page 11

c Prolonged viewing of stereoscopic material in three dimensions might cause fatigue, 
dizziness, or physical discomfort, or might affect your sense of balance.

Feature Film Offline Workflow

Digital cameras can record footage at high-quality resolutions of 2K and up. This makes for 
bright and realistic 3D images that are ideal for digital cinema productions. During the 
post-production process, this quality may only be required during the final finishing stages, so 
it’s best to use a lower resolution for the offline editing, and economize on time and disk space. 
Depending on your delivery requirements, you can finish by switching to a higher target 
resolution, or conforming the project on another editing system where you can view the material 
at higher-than-HD resolution.
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The illustration below shows a typical workflow for feature film editing using both Avid and 
3rd-party applications.

1. Dailies Creation

There are many companies that provide tools and technologies to streamline the preparation of 
stereoscopic dailies. Once the footage to be delivered to editorial has been identified, it is passed 
on in the form of transcoded MXF media or tapes. This footage is either in the original full frame 
format or compressed into a frame compatible format.

The dailies process involves the fixing of timing errors, duration problems, and color or spatial 
alignment between the left/right eye images. Not all these functions need to be completed in the 
dailies as they can be undertaken in the video editing application. Your workflow, timescale, disk 
capacity and other criteria will determine the best flexibility in the pipeline.
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The 3rd-party daily systems also create the necessary stereoscopic grouping metadata to ensure 
that less manual intervention is required in the Avid editing system when the stereoscopic clips 
need to be created.

The processed MXF media is then sent to the creative editorial suite along with the associated 
sequence AAF/ALEs.

2. Offline Editing

If you have adequate disk storage, you can edit all your material in full frame to maintain the best 
possible quality. The application will easily display the full frame material in a frame compatible 
format (e.g. side by side). It is also possible to acquire frame compatible footage for the selected 
takes, and at a later time pass a pull list back to dailies to obtain the full frame equivalents.

Normally, AAFs or ALEs are used to link to MXF files created by other applications in the 
dailies or other upstream processes. Additional metadata can be merged via ALEs into the 
master clips at any time during the editing process.

As editors, you can use the same editorial tools and techniques as if you were cutting 2D footage, 
and simultaneously view the results in stereoscopic 3D on a secondary monitor. Any effects can 
be applied one or both eyes of the stereoscopic media. Any segments that require special visual 
effects processing can be sent to a separate internal or external facility along with the selected 
source media. 

Similarly, a copy of the edited sequence can be sent as an AAF to the audio post facility for the 
audio sweetening. You can import the completed mix back into Media Composer/Symphony for 
the final review.

When the offline edit is complete, you may output an HD master to either file or tape. If 
additional finishing is required, you can send the sequence metadata (AAF/EDL) to a 
stereoscopic 3D-capable finishing system.

3. Conform & Finishing

The finishing workflow takes the conform metadata list (EDL/AAF) from the offline editorial 
system, and relinks to source at the original resolution. The finishing editor can complete all 
aspects of the production with a deeper set of tools.

4. Output

When the production is complete, the final master can be packaged and output to various 
delivery formats (web, film, tape or disc).
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Checklist: Feature Film Offline Workflow

This section outlines the feature film offline workflow for editing stereoscopic footage. Follow 
these steps in the order that they are listed, and return to this checklist each time you complete a 
step. 

Step Refer to this section

 Make sure your system is properly set up with the 
equipment required for stereoscopic editing.

“Setting up your System for 
Stereoscopic Editing” on page 15.

 Understand the basics about stereoscopic editing in 
your Avid editing application.

“Stereoscopic 3D Editing” on page 25.

 Create a stereoscopic project. “Creating a New Project” on page 30.

 Import the pre-processed media from the Dailies 
application:

 Place the MXF media in the Avid MediaFiles 
folder for your Avid editing system, and 
import the AAF/ALE created by the dailies 
application.

“Linking to Stereoscopic MXF Media” 
on page 46.

 If you have any additional metadata for your 
clips, such as information from the camera rig, 
you can import it via log files (ALE).

“Merging Additional Metadata for 
Stereoscopic Clips” on page 48.

 Import any other footage that has been pre-edited by 
upstream processes.

“Importing or Linking Stereoscopic 
Media from File” on page 45.

 Learn about the stereoscopic data model and how to 
manage stereoscopic clips in the bins.

“Working with Stereoscopic Clips” on 
page 51.

 Create the stereoscopic clips from all the master 
clips that have been imported or linked.

“Creating Stereoscopic Clips for Linked 
or Imported Media” on page 56.

 Configure the settings on your various display 
monitors to edit and view the stereoscopic footage.

“Monitoring Stereoscopic Footage” on 
page 65.

 If your stereoscopic footage was not pre-aligned 
during the dailies process, you can apply source side 
corrections to your clips to match the colors in both 
eyes, and fix any spatial or temporal alignments.

“Making Corrections to Stereoscopic 
Clips” on page 75.

 Perform the offline editorial. “Editing Stereoscopic Clips on the 
Timeline” on page 85.
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Live Broadcast Workflow

Many broadcasted events today are being shot in 3D HD by file-based cameras. The video and 
audio signals are fed into an Outside Broadcast (OB) truck, where they are switched and mixed 
into a program signal, and then output from the truck to the TV station and/or direct to air.

The illustration below shows a typical workflow for stereoscopic editing and repackaging of live 
programs, such as televised sports events, using various Avid and 3rd-party applications.

 Apply stereoscopic effects to your clips. “Applying Effects to Stereoscopic 
Clips” on page 89.

 Add the necessary titles to your sequence. “Adding Titles to Stereoscopic 
Segments” on page 102.

 If you require special effects processing by a VFX 
application, export the necessary segments as an 
AAF.

Similarly, you can export the sequence with an AAF 
for the audio sweetening.

You will also need to send them the corresponding 
source media at the best quality.

“Exporting Sequences via AAF or 
EDL” on page 109.

 Output your project to the appropriate medium for 
delivery.

 Output your project to a baseband device such 
as a tape deck or disc recorder.

“Outputting Stereoscopic Sequences to 
a Baseband Device” on page 105.

 Export your project to a media file such as a 
QuickTime movie.

“Exporting Stereoscopic Sequences to 
Media Files” on page 105.

 Export an EDL or AAF of your sequence if 
you need to send your project to another 
editing system for finishing.

“Exporting Sequences via AAF or 
EDL” on page 109.

Step Refer to this section
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1. Filming and Pre-editing

In the OB truck, the Technical Director/Vision Mixer uses the production switcher to select 
between several incoming sources. These include 3D rigs with their video cameras, slow-motion 
replay devices, field recorders and microphones, as well as video servers holding pre-edited 
material. In addition, necessary graphical information is superimposed over the program, such as 
branding, scores, timeclock and captions. The audio feed follows a similar path through the 
audio mixer. All microphones, music/sound effects generators are fed into the audio mixer, and 
the audio engineer mixes, adds and removes whichever audio source is appropriate at the 
appropriate time.

The program signal is then output from the truck to the TV station and/or direct to air. The signal 
may be formatted in full frame, or as frame compatible (side by side) to reduce the bandwidth 
required for transmission via satellite.

The original video and audio signals, together with the program output, and possibly a clean 
version, are stored on DDRs or tape recorders on location to allow more flexible repackaging at a 
later time.

1

Program output

CREATIVE EDITORIAL
& REPACKAGING

4 OUTPUT

FILMING & LINE CUT

WEBCAST

REBROADCAST

TV STATION

OUTSIDE
BROADCAST
TRUCK

LIVE TV BROADCAST

Avid Media
Composer/
Symphony

2

Edited
master

Avid 
Storage

AAF

Avid Pro Tools

Processed
media

L RVideo Rig Metadata AudioM ACG

Graphics
Pre-edited

Promos

Production Switcher

Acquired
media

Playlist

Link back to
source media

CONFORM
 & FINISHING

3

Finishing & 
Visual Effects
Application

Final
master

AAF

TAPE / DISC



Live Broadcast Workflow

15

The ingest controller at the TV station ingests the satellite feed to the storage sub-system. If the 
TV station is transmitting the program to air, there is a playout application running the station’s 
schedule. The program is immediately interspersed with commercials played off the server and 
the live transmission is then aired.

2. Creative Editorial and Repackaging

Live events are typically re-edited and packaged for delivery in other formats such as news 
shows, DVDs, or web casts. The operational center at the TV station gathers the daily media or 
pre-edited programs coming from tape, disk, microwave, or satellite, and archives them on 
servers that all the editors can access. 

Once a script for a show or documentary is written, you can search through the archives and 
piece together the required footage. As an offline editor, you can use the same editorial tools and 
techniques as if you were cutting 2D footage, and simultaneously view the results in stereoscopic 
3D on a secondary monitor. 

You may fix timing errors, duration problems, and left/right eye alignment between the source 
master clips. All this can be done directly at the source level so that the stereoscopic master clips 
can be used successfully throughout the editorial.

When applying effects, you may choose to apply them either to one or both eyes of the 
stereoscopic pair. If there are any segments that require special visual effects processing, you can 
either complete that in the editorial system or export that portion of the sequence to a separate 
system along with the selected source media. 

At the same time you can send a copy of the edited sequence as an AAF to the audio post facility 
for the audio sweetening. The completed mix can then be imported back into the Avid editing 
application. 

Finally, if additional finishing is required, then you can send the sequence metadata (AAF/EDL) 
to a stereoscopic 3D-capable finishing system.

3. Conform & Assembly

The finishing workflow takes the conform metadata list (EDL/AAF) from the offline editorial 
system, and relinks to the sources at the original resolution. The finishing editor can complete all 
aspects of the production with a deeper set of tools. The various the program elements are edited 
into the final program master. These include titles, graphics and end credits, as well as teasers 
and other deliverables. 
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4. Output

When the production is complete, you may output an HD master to either a baseband recorder, 
DVD, or a TV broadcast transmission. Content may also be output in a format suitable for the 
web and other mobile devices.

Checklist: Live Broadcast or In-Studio Workflows

This section outlines the live broadcast workflow for editing stereoscopic footage. Follow these 
steps in the order that they are listed, and return to this checklist each time you complete a step. 

Step Refer to this section

 Make sure your system is set up with the equipment 
required for stereoscopic editing.

“Setting up your System for 
Stereoscopic Editing” on page 15.

 Understand the basics about stereoscopic editing in 
your Avid editing application.

“Stereoscopic 3D Editing” on page 25.

 Create a stereoscopic project. “Creating a New Project” on page 30.

 Acquire the media necessary for your production. “Acquiring Stereoscopic Footage” on 
page 35.

 If your footage is on a baseband device, then 
you can capture it via SDI/HD inputs.

“Baseband Capture of Stereoscopic 
Footage” on page 35.

 If your footage is in a file-based format, then 
you can import or link to the files.

“Importing or Linking Stereoscopic 
Media from File” on page 45.

 If you have MXF media that has been 
generated by an Avid-compliant 
device/application, then you can link directly 
to the MXFs after importing the AAF/ALE.

“Linking to Stereoscopic MXF Media” 
on page 46.

 If you have any additional metadata for your 
clips, such as information from the camera rig, 
you can import it via log files (ALE).

“Merging Additional Metadata for 
Stereoscopic Clips” on page 48.

 Learn about the stereoscopic data model and how to 
manage stereoscopic clips in the bins.

“Working with Stereoscopic Clips” on 
page 51.

 Create the stereoscopic clips from all the master 
clips that have been imported or linked.

“Creating Stereoscopic Clips” on 
page 58.

 Configure the settings on your various display 
monitors to edit and view the stereoscopic footage.

“Monitoring Stereoscopic Footage” on 
page 65.
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In-Studio Production Workflow

TV productions such as daytime dramas, sitcoms, and talk shows are usually shot and edited in 
one location. A typical production studio is divided into separate areas—a stage equipped with 
multiple lights, cameras and microphones; and a control room with all the audio/video switchers, 
graphics generators, recording and playback devices, and monitors. The editing systems are 
normally located onsite as well.

 Apply source side corrections to your clips to fix any 
spatial, temporal or colorimetric alignments.

“Making Corrections to Stereoscopic 
Clips” on page 75.

 Perform the editorial. “Editing Stereoscopic Clips on the 
Timeline” on page 85.

 Apply stereoscopic effects to your clips. “Applying Effects to Stereoscopic 
Clips” on page 89.

 Add the necessary titles to your sequence. “Adding Titles to Stereoscopic 
Segments” on page 102.

 If you require special effects processing by a VFX 
application, export the necessary segments as an 
AAF.

Similarly, you can export the sequence with an AAF 
for the audio sweetening.

You will also need to send them the corresponding 
source media at the best quality.

“Exporting Sequences via AAF or 
EDL” on page 109.

 Output your project to the appropriate medium for 
delivery.

 Output a digital cut to a baseband device such 
as a tape deck or disc recorder.

“Outputting Stereoscopic Sequences to 
a Baseband Device” on page 105.

 Export the sequence as a digital movie for 
final distribution.

“Exporting Stereoscopic Sequences to 
Media Files” on page 105.

 Export an EDL or AAF of your sequence if 
you need to send your project to another 
editing system for finishing.

“Exporting Sequences via AAF or 
EDL” on page 109.

 Transfer completed sequences from your 
video editing system, to an AirSpeed system 
for playout to air.

“Playout” 
- AirSpeed Multi Stream Help

Step Refer to this section
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The illustration below depicts a typical workflow for studio productions edited with Avid and 
3rd-party applications.

1. MultiCamera Shoot and Line Cut

Action in a studio is shot with multiple cameras to get simultaneous views of a scene from 
different angles. The feeds from these cameras are sent to the production control room where the 
media is stored on an Avid ISIS or similar shared storage. Footage received from the field or 
other offsite studios is also captured to the shared storage.

The director drives the creation of the line cut by switching between the cameras as the action is 
happening. The audio is handled much the same way as video. All microphones, music/sound 
effects generators are fed into the audio mixer, and the audio engineer mixes, adds and removes 
whichever audio source is appropriate at the appropriate time. The line cut or program feed is 
then available as a starting point for the creative editorial suite.

2. Creative Editorial

As the episode editor, you can either start with the line cut, and create a fine dialog cut of the 
episode using the clean camera sources when required. 

Avid Media
Composer/
Symphony

2

1

L R

CREATIVE EDITORIAL 3 OUTPUT

MULTICAMERA SHOOT & LINE CUT

Video Rig Metadata AudioM ACG

Graphics
Pre-edited

Promos

TV BROADCAST

Edited
master

FINISHING 4

TAPE / DISC

Final
master

Avid 
Storage

Link to
processed
or source

media

FINISHING
APPLICATION

Production Switcher

AAF

Avid Pro Tools

WEB BROADCAST

Processed
media

CONTROL ROOM

Program output

Acquired
media



In-Studio Production Workflow

19

Edit all your material in full frame at the resolution that will be used for final delivery. The 
application can easily switch to a frame compatible format (e.g. side by side) if you need to 
compare left and right eyes. You can use the same editorial tools and techniques as if you were 
cutting 2D footage, and simultaneously view the results in stereoscopic 3D on a secondary 
monitor.

You may fix timing errors, duration problems, and left/right eye alignment between the source 
master clips. All this can be done directly at the source level so that the stereoscopic master clips 
can be used successfully throughout the editorial.

When applying effects, you may choose to apply them either to one or both eyes of the 
stereoscopic pair. If there are any segments that require special visual effects processing, you can 
either complete that in the editorial system or export that portion of the sequence to a separate 
system along with the selected source media. 

At this point you can send a copy of the edited sequence as an AAF to the audio editor for the 
sweetening. The completed mix can then be imported back into the video editing application.

When the offline edit is complete, you may output a master for review and approval. Many 
facilities use web-based delivery, where you can send a QuickTime or Windows Media file to the 
producers and directors for comments.

If special video finishing is required, then you can send the sequence metadata (AAF/EDL) to a 
stereoscopic 3D-capable finishing system.

3. Conform & Assembly

The finishing workflow takes the conform metadata list (EDL/AAF) from the offline editorial 
system, and relinks to the sources at the original resolution. The finishing editor can complete all 
aspects of the production with a deeper set of tools. The various the program elements are edited 
into the final program master. These include titles, graphics and end credits, as well as teasers 
and other deliverables. 

4. Output

When the production is complete, the final master can be packaged and output to various 
delivery formats (web, tape or DVD).

For a list of steps to follow for this workflow, refer to “Checklist: Live Broadcast or In-Studio 
Workflows” on page 10.
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3 Setting up your System for Stereoscopic 
Editing

This chapter provides information on setting up your equipment to view and edit stereoscopic 
material. Refer to the relevant topic for your Avid editing system:

• “Checklist: Stereoscopic Setup for a Software-Only System with NVIDIA 3D Vision” on 
page 15

• “Checklist: Stereoscopic Setup with Avid Nitris Hardware” on page 21

For a table of all possible Avid configurations that allow editing of compressed/uncompressed 
HD standard and stereoscopic media, see “Hardware Support for Standard and Stereoscopic 
Media” on page 113. 

Checklist: Stereoscopic Setup for a Software-Only 
System with NVIDIA 3D Vision

The following checklist outlines the steps required to connect the NVIDIA 3D Vision equipment 
to your editing workstation. Refer to your product Readme or the Avid Knowledge Base for the 
latest supported NVIDIA drivers.

Step Further Reference

 Determine the configuration that you will be 
using.

“Stereoscopic 3D Configurations for a 
Software-only System” on page 16.

 Install the 3D-ready NVIDIA graphics card in 
your system.

“Using NVIDIA 3D Vision for Stereoscopic 
Editing” on page 17, and the corresponding 
NVIDIA documentation.

 Connect a 3D-compatible monitor to your editing 
workstation for use as the system monitor or as 
secondary display monitor.

“Setting up the NVIDIA 3D Vision 
Components” on page 18, and “Configuring 
the NVIDIA 3D Vision Display” on page 18.

 Configure the NVIDIA 3D Vision active glasses 
to view the monitor.

“Configuring the NVIDIA 3D Vision 
Glasses” on page 20. 
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Stereoscopic 3D Configurations for a Software-only System

The following configurations apply if you are using a software-only Avid editing system. 

Setup for Software-only System (with Single Monitor)

A monitor with 3D capabilities is connected directly to the display port of the NVIDIA card on 
your system. When you switch to Full Screen Playback mode, the monitor is capable of viewing 
stereoscopic media in either full frame or frame compatible format.

Setup for Software-only System (attached to Secondary 3D-Compatible Monitor)

A secondary monitor with 3D capabilities is connected directly to the display port of the 
NVIDIA card on your system. Use this external display monitor in Full Screen Playback mode to 
view stereoscopic media in either full frame or frame compatible format.

Avid editing system with 
stereo 3D-compatible monitor (120 Hz)

Full-screen playback (Full Frame or Frame Compatible)

Display port
of NVidia

Graphics card

Switch to Full-screen playback
to view output in stereo 3D

Avid editing system with 
standard monitor

Full-screen playback (Full Frame or Frame Compatible)

Display port
of NVidia

Graphics card

Secondary stereo 3D-compatible 
monitor (120 Hz)

Display port
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Setup for Software-only System (attached to TV or projector)

A stereoscopic display, such as a projector or TV, is connected from the display port on the 
NVIDIA card to the HDMI port on the attached display. In Full Screen Playback mode, the TV 
or projector can display frame compatible output in stereoscopic 3D on the screen.

Using NVIDIA 3D Vision for Stereoscopic Editing

The NVIDIA® 3D Vision™ configuration is supported on a software-only system. This 
stereoscopic bundle enables 3D monitoring in Full Screen Playback mode on your Avid editing 
workstation. 

n If you have Avid input/output hardware connected to your system, you will not have Full Screen 
Playback enabled. 

To set up the NVIDIA components for stereoscopic 3D editing, you must make sure you have the 
correct NVIDIA software and drivers. Refer to the README for your editing application for the 
latest driver information.

To check the NVIDIA display software version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows 
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information window.

3. If you need to upgrade your driver, then refer to the corresponding instructions in the 
Readme for your Avid editing application.

Avid editing system with 
standard monitor

Display port
of NVidia

Graphics card HDMI port

Stereoscopic Display

Full-screen playback (Frame Compatible only)



Checklist: Stereoscopic Setup for a Software-Only System with NVIDIA 3D Vision

24

Setting up the NVIDIA 3D Vision Components

The NVIDIA 3D Vision components include a graphics card (GPU), specialized 3D glasses, and 
a certified 3D-ready display.

System Requirements

• Microsoft Windows 7 operating system (NVIDIA 3D Vision is not currently supported on 
Mac)

• An NVIDIA® 3D Vision™ Home bundle with the following:

- HP Z800 with NVIDIA Quadro Fermi 4000 PCI-e video board (or better)

or, HP Z400 with NVIDIA Quadro Fermi 2000 PCI-e video board (or better)

- NVIDIA 3D Vision Infrared (IR) emitter and glasses

- 3D-compatible monitors (refer to the NVIDIA 3D Vision web site for a list of 120Hz 
supported displays). 

n The NVIDIA® 3D Vision™ Pro bundle is not currently supported (3D Vision Home and 3D 
Vision Pro are different products. The hub and glasses are not interchangeable.)

Avid has provided basic instructions below to install and configure all these components. To 
ensure that they are configured to work correctly with Avid Media Composer/Symphony, refer to 
these instructions in this guide instead of the documentation that came with your 3D Vision 
glasses. 

Refer to the NVIDIA documentation for the safety requirements, and the Tips and 
Troubleshooting section if you experience any hardware issues during the setup process.

Configuring the NVIDIA 3D Vision Display

The 3D-ready monitor can either serve as your main system monitor, or as a secondary monitor. 
In Full Screen Playback mode, the 3D monitor allows you to view your sequences in 
stereoscopic 3D. Refer to “Monitoring Stereoscopic Footage” on page 65 to understand the 
different ways in which you can view the stereoscopic sequence.

When setting up a two-monitor display, the primary monitor must be of higher or equal 
resolution as the secondary monitor.

Before configuring the display, you must have the appropriate NVIDIA 3D Vision graphics card 
installed. Attach the 3D monitor to your workstation with a dual-link DVI-D cable as shown in 
the diagram below. If there are two DVI ports on your card, use the primary port as this provides 
the higher frequency. (Some monitors may use the Display port. Refer to the manufacturer’s 
instructions for the proper setup for 120Hz operation.)
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n Do not connect the emitter hub unless you have already installed the NVIDIA 3D Vision software 
and related drivers.

To connect the emitter hub:

1. Ensure that the appropriate NVIDIA software and related drivers have been installed on your 
workstation—see “Using NVIDIA 3D Vision for Stereoscopic Editing” on page 17.

2. For best performance, NVIDIA prefers the emitter to be connected to the 3-pin DIN 
connector on the back of the graphics card. If your graphics card does not have this, you will 
require an NVIDIA adapter panel.

Alternatively, you can connect the emitter via a USB port as shown in the illustration above. 
The battery of the glasses is also charged by the USB port.

To configure the NVIDIA 3D Vision display:

1. Open the NVIDIA Control panel.

n The Avid editing application cannot be running while you perform this configuration.

2. Select 3D Settings > Manage 3D settings.

3. On the Global Settings tab, set the Global presets to 3D App - Video Editing.

120 Hz LCD Connection Diagram

LCD

DVI

Hub

USB

WORKSTATION

VESA DVI
USB cable

DO NOT MAKE THIS
CONNECTION UNTIL THE
USB DRIVER IS INSTALLED

Stereo cable [optional]

Dual Link DVI cable
[supplied with the display]
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4. Select Stereo - Display mode and select one of the following:

If your emitter is connected via the 3-pin DIN connector, then select On-board DIN 
connector (with NVIDIA 3D Vision).

If your emitter is connected via an USB cable, then select Generic active stereo (with 
NVIDIA 3D Vision).

5. Select Stereo - Enable and set it On.

n Do NOT select the “Enable stereoscopic 3D” option under the Stereoscopic 3D section of the 
NVIDIA Control panel. The Avid application automatically drives the enabling of stereoscopic 
monitoring when required.

6. Click Apply to save the settings.

7. On your Windows desktop, open the Control panel and select Performance Information & 
Tools. Select Adjust Visual Effects.

8. Select the Visual effects tab and select Adjust for best performance.

Configuring the NVIDIA 3D Vision Glasses

You can view your sequences on a 3D-compatible monitor using active shutter glasses. 

The IR synchronizes the LCD shutter glasses to the display. Since the emitter hub is infrared 
(IR), it must be placed where it can illuminate the 3D glasses. Note that the hub is subject to 
range and line-of-sight restrictions, and any nearby infrared emitters may interfere with the 
signal.

To configure the glasses for use with the 3D-compatible monitor:

1. Ensure that the emitter hub has been connected as explained in “Configuring the NVIDIA 
3D Vision Display” on page 18.

The hub glows dim green when successfully installed and configured.

2. Press and hold the button on the 3D glasses until the light next to the button blinks green.

Release the button and the light will turn bright green. The light on the hub will also turn 
bright green.

The bright green light indicates that the glasses are ready for 3D-viewing.

3. Open the NVIDIA Control Panel.

4. Select Display > Change Resolution.

5. Set the Refresh Rate to 120 Hertz (or thereabouts).
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Disabling Full Screen Stereoscopic Playback in the Avid Editing 
Application

If you no longer require stereoscopic playback on your editing system, you may disable the 
stereoscopic settings on the NVIDIA equipment.

To disable full screen stereoscopic playback:

1. Exit the Avid editing application.

2. Right-click on the desktop to open the NVIDIA Control panel.

3. Select 3D Settings > Manage 3D Settings > Stereo Enable, and set it Off.

4. Select Display > Change Resolution and set the refresh rate of the 3D monitor back to 60 Hz 
(or thereabouts).

5. Restart the editing application.

Checklist: Stereoscopic Setup with Avid Nitris 
Hardware

The following checklist outlines the steps required to connect the Avid Nitris hardware and 
third-party 3D equipment to your editing workstation. 

Step Further Reference

 Determine the configuration that you will be 
using.

“Stereoscopic 3D Configuration with 
Avid Nitris Hardware” on page 22.

Connect to an External Stereoscopic Display

 Connect a stereo projector or TV to your Avid 
system.

Connect your Avid Nitris hardware to your 
workstation and the tape deck

 Refer to the list of the various devices and their 
stereoscopic capabilities.

“Hardware Support for Standard and 
Stereoscopic Media” on page 113.

 Connect the input/output hardware to your editing 
system.

Connecting the Avid Nitris DX poster, 
and “Using the Avid Input/Output 
Hardware” in the help for the Media 
Composer family.
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Stereoscopic 3D Configuration with Avid Nitris Hardware

The following configuration applies if you are using a fully-equipped Avid editing system. 

 If you have the appropriate Avid input/output 
hardware for capture and output, then make sure 
it is connected to your tape deck as required.

Tape deck vendor documentation.

Step Further Reference
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With the full Avid I/O system, there are three options for monitoring on a stereoscopic display 
such as a 3D TV or projector:

1. HDMI to HDMI: Direct the output from the HDMI port on the Avid I/O hardware to the 
HDMI port on the display. This only supports frame compatible media.

2. Dual SDI to Dual SDI: Direct the output from both SDI ports on the Avid I/O hardware to 
the SDI ports on the display. This supports both full frame and frame compatible media.

3. Dual SDI to HDMI: Direct the output from both SDI ports on the Avid I/O hardware to a 3D 
HD converter, which will convert the signal and direct it to the HDMI port on the display. 
This supports both full frame and frame compatible media.

Using the SDI or HDMI Ports on the Nitris DX

On the Avid Nitris DX, there are two main output ports—dual SDI and HDMI. When you use 
SDI, you can capture or output stereoscopic media. HDMI is only used for output.

You can use all the ports on the Nitris DX for simultaneous output. For instance, the SDI ports 
can be used for output to a tape deck, while the HDMI can output to an external viewing device.

SDI Ports

When you input/output frame compatible media, the first SDI port is used (each eye is 
transmitted at half resolution). 

When you input/output full frame media, both SDI ports are used simultaneously. The first one 
transmits the left eye and the second transmits the right eye (at full resolution).

HDMI Port

When you output frame compatible media, the HDMI port transmits both eyes in a frame 
compatible format (each eye is transmitted at half resolution).

When you output full frame media, the HDMI port transmits only the leading eye. 
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4 Stereoscopic 3D Editing 

Unlike traditional 2D editing, stereoscopic editing requires two synchronized images simulating 
our two eyes. Stereoscopic 3D is achieved with a pair of cameras that record footage each 
representing the right and left human eyes. When these left and right images are captured into the 
Avid editing application, they can be combined to produce a single clip allowing you to edit 
stereoscopic material. To view your material in stereoscopic 3D you need a display and glasses 
capable of presenting these images properly to your eyes.

The production pipeline, between the recording of footage to the final delivery, needs to ensure 
that the two media streams are kept to the best resolution and synchronization required for the 
desired output—whether it be to video games consoles, Blu-ray players, broadcast TV, or 
high-end digital cinema.

In the Avid application, stereoscopic media can be edited in one of two formats—full frame or 
frame compatible. Full frame describes a format that represents each eye of the stereoscopic pair 
at full resolution. Frame compatible is used to describe a format where the images from both the 
eyes are squeezed into a single video image (commonly side by side).

Stereoscopic footage can be recorded as a frame compatible format in one of two ways:

• By an upstream generation process. e.g. a number of outside broadcasts and television 
productions create frame compatible media as primary production essence since the signal is 
easier to transmit and distribute using the current baseband signal infrastructure. 

• From full frame sources which are processed and converted to frame compatible format by 
an external device (e.g. SRW5800-2 deck).

1920

1080

1920

1080

LEFT & RIGHT EYE IMAGES 
STORED AS SEPARATE FULL FRAMES

LEFT RIGHT

LEFT & RIGHT EYE IMAGES 
STORED IN SINGLE FRAME

FRAME COMPATIBLEFULL FRAME
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For the best quality images in production, you should capture and store your images as full 
frames as they will give you more flexibility with your final delivery formats. During the 
post-production process, you still have the option to edit with these images in a lower-resolution, 
frame-compatible mode.

c Prolonged viewing of stereoscopic material in three dimensions might cause fatigue, 
dizziness, physical discomfort, or might affect your sense of balance.

Working in Stereoscopic Projects

When working with stereoscopic media there are some key places in the Avid editing application 
where you need to set your stereoscopic preferences. The diagram below shows the different 
points in the pipeline where the stereoscopic preferences are set and used.

Project Settings

The Stereoscopic project setting determines how editing functions (such as renders) will be 
performed on stereoscopic material that has already been acquired on your storage device.

If media at the selected stereoscopic format is available on your storage, then it will be used 
when editing any stereoscopic clips that are placed on the timeline. Even if full frame media has 
been acquired, you can still use the frame-compatible stereoscopic options. The Avid application 
will squeeze the full frame images into a side by side or over/under format so that you can work 
with lower-resolution images.

Project Settings
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In the initial editing stages, when it is important to review your footage rapidly to put together a 
rough cut, you can edit using a single eye from the stereoscopic clip—either the leading eye, left 
eye, or right eye. It is important to note that any renders, mixdowns, transcodes will only be done 
on the selected eye. If you require higher-quality images, you can switch to full frame mode to 
add effects, and color correct your images. For a full list of editing functions and how the 
stereoscopic media is handled, see “Editing Stereoscopic Clips on the Timeline” on page 85.

You set the stereoscopic project mode when you create a new project. However, you can change 
the setting at any time during the editing process.

Capture Settings

When you capture footage from a baseband device, you must set the capture settings to stereo to 
allow the tool to create stereoscopic clips in the bin. You must also choose the format in which 
your footage was recorded. e.g. full frame or frame compatible. 

If you are importing or linking to files, there are no specific format settings. The files are 
imported in the format at which they were acquired and stored as monoscopic clips.

Composer Viewer Settings

Various stereoscopic viewer modes are available in the display monitors. These modes can be set 
differently than the stereoscopic project setting to accommodate the editing task that you are 
performing. 

The Source and Record monitors in the Avid editing application, the full-screen playback, as 
well as any attached external display, each have S3D view modes that you can set independently. 
The best arrangement is to use your system monitor for editing and to have a separate 
stereoscopic display to monitor your results with 3D glasses.

A common approach is to work with the leading eye to do your rough cut. For example, you can 
set the source monitor to Mono > Leading Eye view mode while reviewing your footage. Then, 
when you are ready to start correcting the color or spatial alignment between the left and right 
images, set the record monitor to Frame Compatible view mode.

To view your images more closely, or see the final result of the combined images in stereoscopic 
3D, set the external stereoscopic display device (3D-compatible monitor, TV or projector) to Full 
Frame view mode. 

n On a software-only system (i.e. no input/output hardware connected), you can also use the 
various stereoscopic view modes in full-screen playback.
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Video Output Settings

When you are ready to do a digital cut of your sequence, you can override the stereoscopic 
project setting using the Video Output tool. This tool also has the various stereoscopic view 
modes to allow you to output your sequence in any format. For example, should you need to use 
frame compatible media as a delivery format, your Avid editing system (with the appropriate 
hardware) can generate side by side media from two full frame sources.

If you are exporting to file, such as a QuickTime movie, the application uses the stereoscopic 
project setting.

Example: Using the Different Stereoscopic 3D Editing and Viewing 
Modes

The following example shows the flexibility of capturing, viewing, editing and outputting your 
media in the various modes when you work in a stereoscopic project.
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1 Capture Settings Capture your stereoscopic media in FULL FRAME format at the 
desired resolution.

2 Project Format Settings Set your project to SIDE BY SIDE format so that you can edit in a 
lower resolution. All clips that are placed on the timeline will be 
interpreted and formatted to frame compatible for all editing 
functions.
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Hardware Monitoring
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Storage with 
FULL FRAME
Stereo Media Source Monitor

 set to
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Record Monitor set to
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Creating a New Project
You can create a project in any format. The settings you choose for your project will dictate the 
way in which your material is handled for the various editing functions within the Avid 
application.

To create a new project:

1. Start your Avid editing application.

2. In the Select Project dialog box, select the folder in which you want to create the project: 
Private, Shared, or External—see “Working with Projects” in the Help. 

3. Click New Project.

The New Project dialog box opens.

4. Type the name of your new project in the text box.

5. Click the Format menu and select a project format that matches your media and delivery 
requirements. 

The rest of the options might change depending on the project format you choose.

3 Composer Settings for
Source/Record Monitors

The application sends the stereoscopic content to the monitor in the 
format specified by the project settings. In this example, the project 
has been set to SIDE BY SIDE so the monitors will simply inherit 
the side by side layout. You can, however, set each monitor to view 
the content in a different view mode.

For example, the source monitor is set to LEFT EYE, so it will only 
display the left eye.

The record monitor on the other hand, has been left at the FRAME 
COMPATIBLE MODE so that differences between the left and 
right eye can be corrected.

4 Full Screen Playback 
Settings

If you are working on a software-only system, with no Avid 
input/output hardware, the external stereo 3D-compatible monitor 
can be set to a FULL FRAME view mode if you want to view the 
results with 3D glasses.

You can also set it to one of the blended modes, e.g. MIX, if you 
want to view the image more closely when correcting the alignment 
on your images.

5 Video Output Tool Settings If you have Avid input/output hardware, you can set the monitor 
according to the mode that you want to view and output your 
sequence.
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Example of the New Project dialog box

6. Set the following option(s), where applicable:

n If you are working in a stereoscopic project, then select the appropriate stereocopic option 
below. If you are working in a standard project, the stereoscopic option must be set Off.

If you are in an SD project, the menus that control stereo 3D are not available. You can only 
work with stereoscopic material in an HD project.

Option SD HD

Aspect Ratio The project uses the aspect ratio setting to determine 
the display setting in the monitors, and as a factor in 
determining whether material requires resizing or 
repositioning in sequences. For more information, see 
the Help.

Select either 
4:3 or 16:9

Always uses the 16:9 
aspect ratio.

Raster 
Dimension

The Raster Dimension menu appears only for HD 
projects on a supported system. For more information, 
see the Help. 

N/A

Color Space Specifies the color space for some HD project types, 
either RGB 709 or YCbCr 709. For more information, 
see the Help  .

N/A
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Stereoscopic Specifies how to handle stereoscopic clips for the 
various editing functions within your project.

Available only for 1080i 
and 1080p HD projects.

Off Turns Stereoscopic functionality off. 

Any stereo material in the sequence is 
treated as a standard format, and only 
the leading eye image is used.

Leading Eye Uses the leading eye image from a 
stereo master clip. The leading eye 
image is defined by the S3D Leading 
Eye clip attribute.

Left Eye Only Uses the left eye image from a stereo 
master clip.

Right Eye 
Only

Uses the right eye image from a stereo 
master clip.

Side by Side Frame compatible format that uses the 
left and right eye images one beside 
the other using horizontal half res for 
each eye.

If you have any standard (non-stereo) 
material in the sequence, it will use the 
same image in both the left and right 
frames.

Over/Under Frame compatible format that uses the 
left and right eye images one over the 
other using vertical half res for each 
eye.

If you have any standard (non-stereo) 
material in the sequence, it will use the 
same image in both the top and bottom 
frames.

n When using source material 
that is full frame, the frame 
compatible format is generated 
on the fly which may result in a 
performance slowdown.

Option SD HD
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7. Click OK.

Your Avid editing application creates the new project files and folder, and then returns to the 
Select Project dialog box. The project name is highlighted in the Projects list. 

8. Double-click the project name to open the project.

The Project window, the Composer window, and the Timeline open with your User settings 
loaded.The Project window, the Source/Record monitor, and the Timeline open with the 
User settings loaded.

Project name and user name in the title bar (left) and Close button (right) in the Project window

9. (Option) If your project uses a film project type, set film preferences immediately after you 
create the project.

Film Available for 23.976p, 24p, 25p, 720p, and 1080p film 
projects. Click the Film button and select a format for 
film gauge tracking from the Default Film Type menu.

N/A

Audio 
Transfer Rate

Available for 24p PAL projects. N/A

Matchback Available for 25i PAL, 30i NTSC, 720p, and 1080i 
Matchback projects only. Select Matchback, then click 
the Film button and select a format for film gauge 
tracking from the Default Film Type menu. The 
Matchback item appears only if your Avid editing 
application includes the Matchback option.

Option SD HD
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5 Acquiring Stereoscopic Footage

Stereoscopic material can be acquired in one of the following ways:

• Baseband capture

• Import from file

• Link to file via AMA

• Import AAF/ALE, and link to externally-generated MXF media

Baseband Capture

Stereoscopic footage can be captured from baseband SDI/HD inputs in full-frame or 
frame-compatible format. Recording devices from which Avid applications can capture footage 
include tape-based VTRs, digital cameras and disk-based recorders.

Import from File or Link with AMA

Stereoscopic files from a third-party device (a camera, reader, or removable drive) can be 
imported directly into the application. For stereoscopic workflows, we recommend that you first 
copy these files to a high-bandwidth storage device connected to your system before importing 
the files or linking to them via AMA.

Link to Externally-Generated MXF Media via AAF/ALE

If you have MXF media that has already been generated by other third-party applications, you 
can import the AAF/ALE containing the associated stereoscopic metadata, and link directly to 
the MXF media which has been placed in the appropriate Avid\MediaFiles\MXF location.

Baseband Capture of Stereoscopic Footage

Baseband video of stereoscopic footage is transmitted using HD/SDI inputs and can be 
transported over one or more links for capture into the Avid editing application. The application 
is capable of capturing baseband video that is either in full frame or frame compatible format. 
During capture, there are several settings that allow you to specify the format of the source 
material and the way that the left and right eye footage is captured.

The following scenarios are supported:
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Capture of Left/Right Eyes from Separate Sources

This scenario is with content coming from two separate sources. Each source has a single video 
signal which carries one of the eyes in the stereo pair. Each source is captured separately into the 
Avid application, and the timecodes could either be the same or different for each eye.

See “Capturing Full Frame Footage from Separate Sources” on page 41.

Simultaneous Capture of Left/Right Eyes from a Single Source

This scenario is with a single source with eyes recorded on separate channels: Two video signals 
are output with the left eye content on one channel and the right eye on the other. Both channels 
are ingested into the Avid application simultaneously, and timecodes are the same for each eye.

See “Capturing Full Frame Footage from the Same Source (Simultaneous)” on page 42.

Capture of Left/Right Eyes from a Single Source (Two-Pass)

This scenario is with a single source containing both eyes, and with only a single video output. 
The video signal will only output one eye at a time, therefore the footage must be captured into 
the Avid application in two passes—one pass for each eye with the correct starting timecode 
specified.

TWO SEPARATE SOURCES FOR EACH EYE

LEFT EYE

RIGHT EYE

BOTH IMAGES STORED AS FULL FRAMES

1920

1080

LEFT EYE_L RIGHT EYE_R

LEFT CHANNEL

RIGHT CHANNEL

SINGLE SOURCE WITH TWO VIDEO SIGNALS BOTH IMAGES STORED AS FULL FRAMES

1920

1080

LEFT EYE_L RIGHT EYE_R
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See “Capturing Full Frame Footage from the Same Source (Two-Pass)” on page 43.

Capture of Left/Right Eyes in a Frame Compatible Format

This scenario is with a single source with both eyes recorded in a frame compatible format 
(either over/under or side/side). One video signal is output with both eyes. Both eyes are ingested 
into the Avid application simultaneously, and stored in a single frame.

See “Capturing Frame Compatible Stereoscopic Footage” on page 44.

Batch Recapturing Stereoscopic Clips

Stereoscopic clips are formed by referencing master clips from the left and right eyes. 
Unfortunately, in this version of the software, the stereoscopic clips themselves cannot be batch 
captured. To recapture any stereoscopic content in a batch, you must perform the capture from 
their contributing master clips.

Opening the Capture Tool

To open the Capture tool:

1. Ensure the deck or other playback device is properly connected to the system and is turned 
on.

2. Do one of the following:

t Click a bin to activate it and select Bin > Go To Capture Mode.

t Select Tools > Capture.

ONE SOURCE CONTAINING BOTH LEFT AND RIGHT EYES
WITH OUTPUT ON A SINGLE VIDEO SIGNAL

LEFT EYE

RIGHT EYE

BOTH IMAGES STORED AS FULL FRAMES
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1080
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CONTAINING BOTH EYES IN EACH FRAME
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3. Set the Capture tool to either Log or Capture mode by clicking the Capture/Log Mode button 
until the correct mode displays.

Capture Tool: Options for Stereoscopic Material

When working in a stereoscopic project, the following additional options are presented for 
baseband capture of stereoscopic footage:

n If the Capture Tool is open when you switch the format of your project from standard to stereo, 
these additional options will not be available unless you close and reopen the tool.

Stereo 3D Source Settings

Stereo 3D Handling Settings

Stereo 3D Location Settings

Timecode Settings
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Stereoscopic 3D Source Settings

The following settings are available at the top of the Capture Tool to define the source material in 
a stereoscopic project. 

Stereoscopic 3D Handling Settings

The following settings are available to include additional metadata in the captured or logged 
master clips:

Stereoscopic 
3D Source 
Settings Option Description

Masterclip type Stereo Create stereoscopic clips.

Mono Creates standard master clips.

n When this option is selected, all the 
stereoscopic options in the Capture tool are 
grayed out.

Essence type Full Indicates that the source material is full frame 
format.

FC Side by Side Indicates that the source material is frame 
compatible format with a side by side layout.

FC Over/Under Indicates that the source material is frame 
compatible format with an over/under layout.

Tape Layout Simultaneous L+R Indicates that the footage for each eye is coming 
from the same source but each eye has a separate 
video channel.

Separate tapes Indicates that the footage for each eye is coming 
from separate sources.

Single tape Indicates that the footage for both eyes are on the 
same source. The left and right eyes may be in 
alternating frames, or they may be in frame 
compatible format (over/under or side/side).
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Stereoscopic 3D Location Settings

The following settings are available for you to organize your master clips and stereoscopic clips 
as the media is being captured.

For details on other settings in the Capture Tool, refer to the following topics in the Help:

Timecode Settings for S3D

The following settings allow you to set the start, end and/or duration timecodes for the left and 
right eye footage to be captured.

Stereoscopic 3D 
Handling Settings Option Description

Leading Eye Determines which eye will be used when the stereoscopic project 
setting is set to “Leading eye”. (This eye will also be displayed in 
the Frame view of the bin.)

Left Sets the left eye as the leading eye.

Right Sets the right eye as the leading eye.

Master TC Left/Right When the stereoscopic clip is created, the 
timecode from this eye will be used as the starting 
timecode.

Stereoscopic 3D 
Location Settings Description

Bin Indicates the bin where the contributing master clips for each eye 
will be placed.

S3D Bin The contributing master clips will automatically be grouped to 
create the stereoscopic clips. You can indicate the bin where the 
stereoscopic clips will be placed.

Res Select the resolution at which the clips will be captured.

Select the drive(s) where the media will be stored.
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For details on other settings in the Capture Tool, refer to the online Help.

Capturing Full Frame Footage from Separate Sources

When the left and right eye footage is recorded on two separate sources, each source needs to be 
captured separately into the Avid application. The application will record all the images from the 
first eye and then prompt you to enter the tape for the second eye. The metadata for the tape 
name will automatically be appended with an _L or _R to distinguish between the left and right 
tapes. Similarly, as the master clips are created in the bin, the clips for each eye are appended 
with an _L or _R.

After the capture is complete, the master clips for each eye are matched and a full-frame 
stereoscopic clip is automatically created.

When you have separate tapes for the left and right eye, the following settings are required in the 
Capture Tool:

Timecode Settings 
for S3D 

Description

Same TC When this option is selected, the same timecodes will be used for 
the left and right eye footage. Enter the start, end, and duration 
times in the timecode selector boxes.

When this option is not selected, use the drop down menu to set the 
Left or Right eye timecodes separately. Enter the start, end, and 
duration times in the timecode selector boxes. Repeat this for each 
eye.

TWO SEPARATE SOURCES FOR EACH EYE

LEFT EYE

RIGHT EYE

BOTH IMAGES STORED AS FULL FRAMES

1920

1080

LEFT EYE_L RIGHT EYE_R

Option Choose

Masterclip type Stereo
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Capturing Full Frame Footage from the Same Source (Simultaneous)

When the left and right eye footage is recorded on a single source but on two separate channels, 
both eyes can be captured simultaneously into the Avid application. Two video signals are 
output—the left eye content on one channel and the right eye on the other. Timecodes are the 
same for each eye. 

As the master clips are created in the bin, the clips for each eye are appended with an _L or _R. 
After the capture is complete, the master clips for each eye are grouped and a full-frame 
stereoscopic clip is automatically created.

The following settings are required in the Capture Tool:

Essence type Full

Tape Layout Separate tapes

Timecode IN box Enter the start timecode for the eye(s) that you are capturing.

Same TC Select this option to use the same timecode for both eyes.

If the timecodes are not the same, then select Left or Right from the 
dropdown selection, and then enter the respective timecode in the 
Timecode IN box. Repeat this for each eye.

Tape name? Enter a name for your tape. When working with multiple tapes in a 
stereoscopic project, the application automatically appends the tape name 
with an _L or _R to distinguish between the left and right tapes. This 
source tape name is included in the metadata associated with the master 
clips. During capture, this naming convention will be used to prompt you 
to insert the appropriate tape. 

Option Choose

LEFT CHANNEL

RIGHT CHANNEL

SINGLE SOURCE WITH TWO VIDEO SIGNALS BOTH IMAGES STORED AS FULL FRAMES

1920

1080

LEFT EYE_L RIGHT EYE_R

Option Choose

Masterclip type Stereo
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Capturing Full Frame Footage from the Same Source (Two-Pass)

When the left and right eye footage is recorded on the same source, one video signal is output for 
each eye. The footage must be captured into the Avid application in two passes—one pass for 
each eye with the correct starting timecode specified.

When all the frames for the first eye are captured, the device cues to the start of the second eye 
and begins capturing. As the master clips are created in the bin, the clips for each eye are 
appended with an _L or _R. After the capture is complete, the master clips for each eye are 
grouped and a full-frame stereoscopic clip is automatically created.

n To perform a two-pass capture, you must enter valid timecodes for the start of each capture. 
Capturing “on-the-fly” is not supported. 

The following settings are required in the Capture Tool:

Essence type Full

Tape Layout Simultaneous L+R

Timecode IN box Enter the start timecode for the eye(s) that you are capturing.

Tape name? Enter a name for your tape. This source tape name is included in the 
metadata associated with the master clips. During capture, this name will 
be used to prompt you to insert the appropriate tape. 

Option Choose

ONE SOURCE CONTAINING BOTH LEFT AND RIGHT EYES
WITH OUTPUT ON A SINGLE VIDEO SIGNAL

LEFT EYE

RIGHT EYE

BOTH IMAGES STORED AS FULL FRAMES

1920

1080

LEFT EYE_L RIGHT EYE_R

Option Choose

Masterclip type Stereo

Essence type Full

Tape Layout Single tape
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Capturing Frame Compatible Stereoscopic Footage

Stereoscopic footage can be recorded in a frame compatible format which combines full frame 
images from both the eyes into a single image (either over/under or side/side). This requires a 
form of a spatial compression and results in less than full resolution for each of the eyes.

When the left and right eye footage is captured from the same source in a frame compatible 
format, one video signal is output containing both eyes. Both eyes are ingested into the Avid 
application simultaneously, and stored in a single frame with each eye at half the resolution.

After the capture is complete, a frame-compatible stereoscopic clip is automatically created.

The following settings are required in the Capture Tool:

Same TC Deselect this option and set the drop down menu to Left or Right. Enter 
the start, end, and duration times in the timecode selector boxes. Repeat 
this for each eye.

Tape name? Enter a name for your tape. This source tape name is included in the 
metadata associated with the master clips. During capture, this name will 
be used to prompt you to insert the appropriate tape. 

Option Choose

SINGLE SOURCE WITH A SINGLE VIDEO SIGNAL
CONTAINING BOTH EYES IN EACH FRAME

LEFT & RIGHT

SIDE BY SIDE

LEFT RIGHT

LEFT & RIGHT EYE IMAGES
STORED IN SINGLE FRAME

1920

1080

Option Choose

Masterclip type Stereo

Essence type FC Side by Side

FC Over/Under

Tape Layout Single tape

Timecode IN box Enter the start timecode for the footage that you are capturing.

Same TC Select this option as the same timecode applies to both eyes.
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Importing or Linking Stereoscopic Media from File

When full frame essence is recorded to file, the left and right eye content are stored in separate 
stream-based files. Each of these files need to be imported into your Avid editing application.

When frame compatible essence is recorded to file, the left and right eye images are squeezed 
into a standard video image (side/side or over/under) in a single stream. This requires a form of 
spatial compression and results in less than full resolution for each of the eyes. When the footage 
is imported into your Avid editing application, it is stored in a single frame with each eye at half 
the original resolution.

We strongly recommend that you create a separate bin for each eye that you are importing. This 
will make the clips much easier to sort and manage during the stereoscopic clip creation process. 
For details on importing media from file, see “Importing Media Files” in the Help.

n After the files are imported and the master clips are created in the bin, these clips must manually 
be selected and converted into stereoscopic master clips before you do any stereoscopic editing. 
See “Creating Stereoscopic Clips for Linked or Imported Media” on page 56.

Tape name? Enter a name for your tape. This source tape name is included 
in the metadata associated with the master clips. During 
capture, this name will be used to prompt you to insert the 
appropriate tape. 

Option Choose

TWO SEPARATE STREAM-BASED FILES FOR EACH EYE

LEFT EYE

RIGHT EYE

IMAGES STORED AS FULL FRAMES

1920

1080

LEFT EYE_L RIGHT EYE_R

SINGLE STREAM-BASED FILE WITH BOTH EYES

SIDE BY SIDE

LEFT & RIGHT EYE IMAGES
STORED IN SINGLE FRAME

LEFT & RIGHT

LEFT RIGHT

1920

1080
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Linking to Stereoscopic Files via AMA

Linking to stereoscopic files via AMA is more efficient than importing these files into your Avid 
application. You can manipulate and edit this media as you would any other clip or sequence.

For stereoscopic workflows, we recommend that you first copy these files to a high-bandwidth 
storage device connected to your system before linking to them via AMA.

To link to stereoscopic files via AMA:

1. Select File > Link to AMA Volume.

2. Browse to the location where your files are located and select the top level folder containing 
any subfolders where the left and right eye files are stored.

3. In the Bin Selection dialog, select Single Bin Based on Selected Folder.

Avid recommends using this option as all the master clips will be created in a single bin. 
This will make it easier to select and group these clips into stereoscopic clips.

4. Once the clips are created in the bin, you need to follow certain rules to populate the 
appropriate columns so that stereoscopic clips can be created.

A number of cameras support Avid’s scheme for stereoscopic 3D metadata. When you link 
to these files via AMA, the S3D group name and channel are already populated so all you 
have to do is create the stereoscopic clips.

If these columns are not populated, then see “Creating Stereoscopic Clips for Linked or 
Imported Media” on page 56.

Linking to Stereoscopic MXF Media

Your facility may have a pipeline which creates processed or aligned stereoscopic MXF files 
using a dailies application. The dailies system should also generate an ALE or AAF file of this 
media which can be imported into the Avid to generate bins with master clips that point to the 
MXF media. In the case of an AAF, the media should relink automatically. However, a relink 
operation will be required when using an ALE. 

n If an AAF/ALE is not available, then you can use the Avid Media Tool to create clips from the 
MXF media.

If you are using both full frame and frame compatible essence with the purpose of using frame 
compatible essence for faster, lightweight or remote editing, Avid recommends that you organize 
the folders on your storage to segregate each of the channels into a separate essence folder. In the 
case of remote editing, the frame compatible essence could be located on a local drive to allow 
disconnected operation.
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Here is an example of how you can structure your folders:

Keeping media from the same source (at all available resolutions) in the same folder, will also 
ease the file maintenance and facilitate the reimport process in the event that a different 
resolution of a clip is required.

To link to MXF media via AAF/ALE:

1. Make sure that all your transcoded MXF files are located in the appropriate Avid MediaFiles 
folder (drive letter:\Avid MediaFiles\MXF\).

2. Open the bin in which you want to create the master clips.

3. Right-click in the bin, and select Import.

4. Locate the AAF or AFE file that you want to import and click Open.

If you imported an AAF, all clips in the bin will automatically be linked to the corresponding 
MXF media.

If you imported an AFE, you will need to use the Relink operation to link to the 
corresponding MXF media.

5. Once the master clips are successfully created in the bin, you need to follow certain rules to 
pair the left and right images into a stereoscopic clip—“Creating Stereoscopic Clips for 
Linked or Imported Media” on page 56.

n Some third-party vendors support Avid’s scheme for stereoscopic 3D metadata. When you link to 
these files, the S3D Group Name and S3D Channel are already populated with the appropriate 
information required to create the stereoscopic clips.

To link to MXF media via the Media Tool:

1. Select Tools > Media tool.

2. Select the media drives where the MXF files are located.

3. Select the project where you want to create the master clips.

Only the projects with associated online media and the current project appear in the 
Project(s) list in the Media Tool Display dialog box.

4. Sort the clips by creation date and select the clips that you need.

Folder Media Type

\Avid MediaFiles\MXF\1 Full frame, left eye images

\Avid MediaFiles\MXF\2 Full frame, right eye images

\Avid MediaFiles\MXF\99 Frame compatible images
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5. Drag these clips into your bin.

n Some third-party vendors support Avid’s scheme for stereoscopic 3D metadata. When you link to 
these files, the S3D Group Name and S3D Channel are already populated with the appropriate 
information required to create the stereoscopic clips. You can reveal the S3D columns to see if 
this information has been included.

6. Once the master clips are successfully created in the bin, you need to follow certain rules to 
pair the left and right images into a stereoscopic clip—“Creating Stereoscopic Clips for 
Linked or Imported Media” on page 56.

Merging Additional Metadata for Stereoscopic Clips

You can import additional metadata, such as information from the camera rig, and merge it with 
existing master clips in a bin. When importing this metadata, you will need to follow the Avid 
conventions for the stereoscopic bin columns. For more information, refer to How to create Avid 
Stereoscopic Essence and Metadata in the Avid Knowledge Base.

To merge additional metadata into a bin:

1. Select the master clips for which you have additional metadata to merge.

2. Right-click on one of the clips, and select Import.

3. Locate the ALE file holding the metadata that you want to import, and click Open.

4. (Option) If you want to select options for combining events on import, click Options to open 
the Import Settings dialog box. Select one of the options below from the Shot Log tab, and 
then click OK to close the Import Settings dialog box and return to the Select Files to Import 
dialog box.

Option Description

Merge events with known 
sources and automatically 
create subclips.

When this option is selected, your Avid editing application creates 
subclips for events that are merged or relinked to their source clips 
upon import. Use this option if you have already entered master clips in 
a bin for each camera roll or master scene, and have subsequently 
logged all the events related to those clips for import.

n You must select the clips that you want to merge before selecting 
this option.
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5. Select the source file from the list and click the Open button.

When your Avid editing application finishes importing the file, the clips (or new metadata 
for the clips) will appear in the selected bin.

Merge events with known 
master clips.

When this option is selected, your Avid editing application merges 
information in the shot log onto selected master clips based on the 
matching tape name. Use this option if you have already logged (or 
captured) master clips in a bin for each take.

n You must select the clips that you want to merge before selecting 
this option.

Option Description
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6 Working with Stereoscopic Clips

This section describes how to create and manage stereoscopic clips in your project. If your 
project format is set to one of the stereoscopic formats, then your Avid editing application will 
allow you to capture, create, and edit with stereoscopic clips. If you change your project format 
to non-stereoscopic, you will still be able to use stereoscopic clips on the timeline. However, 
only one of the eyes (the leading eye) will be used.

What is a Stereoscopic Clip?

A video master clip is created when an incoming video signal of a definite start and end time is 
captured in the Avid editing application. In the case of full frame stereoscopic footage, which has 
essence from two eyes, separate master clips are created for the left and right eyes. A 
stereoscopic clip is then created to reference these master clips.

For stereoscopic footage that is recorded in a frame compatible format, both eyes are squeezed in 
a single frame (side/side or over/under), therefore only one master clip is created. However, this 
clip must still be tagged as a stereoscopic clip before it can be used for editing within a 
stereoscopic project.

This also applies to clips that are created when media is imported from file, or linked via AMA.

The same stereoscopic footage can be acquired and stored on your disk storage in various 
formats—full frame, frame compatible, or monoscopic.The Avid editing application recognizes 
media from the same source and uses one stereoscopic clip to represent all theses formats. This 
gives you greater flexibility during the editing process as it allows you to switch your 
stereoscopic project format to use any of the formats available on disk.

The following illustration shows how the various master clips are associated to the stereoscopic 
clip. In this example all variations are shown. In the most common cases, only the left and right 
eye, and some form of a frame-compatible format will be necessary.
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The metadata from the source material, as well as any other attributes entered during the 
acquisition process, are preserved with the clips in the bin. These attributes, especially the 
channel and group name, are important determinants for the creation of the stereoscopic clips. 
All attributes can be displayed in the bin—see “Displaying Stereoscopic Clips in Bins” on 
page 52.

n Stereoscopic clips are automatically created for media captured from tape. However, when you 
import stereoscopic media from file, you may need to create the stereoscopic clips manually if 
the channel and group name were not included into the media’s metadata—see “Creating 
Stereoscopic Clips for Linked or Imported Media” on page 56.

Displaying Stereoscopic Clips in Bins

Stereoscopic clips can be easily be distinguished in the bin by their icon. If your stereoscopic 
clips or metadata are not visible in the bins, then follow the procedure below.

Frame Compatible
OVER_UNDER 

Frame Compatible
SIDE_BY_SIDE 

MASTER CLIPS
CREATED IN BIN

STEREOSCOPIC
CLIP

GENERATED
IN BIN

Full Frame
LEFT

Full Frame
RIGHT

Full-Res
Stereo Media

Half-Res
Stereo Media

Half-Res
Stereo Media

AVAILABLE
MEDIA VERSIONS
ON DISK STORAGE

A single Stereo Clip is generated 
for all captures done for the same
timeframe.

Full-Res
Stereo Media

CAPTURE/IMPORT
FORMAT

Monoscopic Standard 
Full-Res Media
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To display stereoscopic clips in a bin:

1. Ensure that the bin is active.

2. Select Bin > Set Bin Display.

3. Select Stereoscopic Clips, and then click OK.

To display the stereoscopic bin columns that contain stereoscopic data:

1. Right-click on a column heading and select Choose Columns.

The Bin Column Selection list displays.

2. Select or deselect the columns that you want to display or hide. Columns related to 
stereoscopic information all start with “S3D” (stereoscopic 3D).

Bin Settings for Stereoscopic Clips

The following attributes are available for your clips when the Project format is set to a 
stereoscopic mode:

Bin column Description

Stereoscopic Clip 

Master Clip

Name Displays the name of the master clip or the stereoscopic clip. 

When capturing from tape (in the case of full frame media), 
the left and right master clips will have _L and _R appended 
to their names.

S3D Channel Allows you to set which channel this master clip will deliver 
into the stereoscopic clip. (Left eye, right eye and monoscopic 
are full frame channels, while Side by Side and Over/Under 
are frame compatible channels.)

Left Eye: Indicates that the contents of this clip are to be used 
as the Left eye.

Right Eye: Indicates that the contents of this clip are to be 
used as the Right eye.

Over/Under: Indicates that this is frame compatible media in 
an over/under format.

Side by side: Indicates that this is frame compatible media in 
a side by side format.

Monoscopic: Indicates that this is a standard 2D clip (not 
stereoscopic).
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S3D Group name A common name used to identify all master clips originating 
from the same stereoscopic footage. The group name is used 
by the application to create a single stereoscopic clip that 
references these master clips. Therefore, this name must be 
exactly the same for all clips that need to be grouped into a 
stereoscopic clip.

When material is captured from tape, this field is 
automatically populated for all the left and right eye master 
clips.

When material is imported/linked from file, this data may not 
be present. If so, you can select the clips in the bin and request 
for auto-population of the group name.

If an S3D Clip name is not specified, then the group name is 
used to name the stereoscopic clip when it is created.

S3D Clip name Enter a name here that will be used to name the stereoscopic 
clip when it is created. The name only needs to be set for one 
of the contributing master clips. If no name is entered for any 
of the contributing clips, then the S3D Group name will be 
used instead.

S3D Inversion Allows you to specify if and how the contents of this clip 
should be inverted before being used.

This is useful when beam-splitter rigs are used during filming, 
and a mirror is used to create the image for one of the eyes. In 
this case, one of the eyes will be inverted so it needs to be 
corrected

None: Leaves the image as is.

Horizontal: Inverts the image horizontally.

Vertical: Inverts the image vertically.

Horizontal/Vertical: Inverts the image horizontally and 
vertically.

Bin column Description
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S3D InversionR Only available if the media is in a frame compatible format 
with the S3D Channel set to either Over/Under or Side by 
Side.

Allows you to specify how the part of the image that provides 
the right eye should be inverted before being used.

None: Leaves the image as is.

Horizontal: Inverts the right eye image horizontally.

Vertical: Inverts the right eye image vertically.

Horizontal/Vertical: Inverts the right eye image horizontally 
and vertically.

S3D Eye Order Only available if the media is in a frame compatible format 
with the S3D Channel set to either Over/Under or Side by 
Side.

Specifies which half of the image the eye is displayed.

Left-Right:

• For Side by Side format, the Left eye is on the left, the 
Right eye is on the right.

• For Over/Under format, the Left eye is in the top half of 
the image, Right eye is in the bottom.

Right-Left: 

• For Side by Side format, the Right eye is on the left, Left 
eye is on the right.

• For Over/Under format, the Right eye is in the top half of 
the image, Left eye is in the bottom.

The following columns are displayed only for stereoscopic master clips:

S3D Contributors Lists the S3D Channels (master clips) that feed into the 
stereoscopic clip.

S3D Leading Eye Allows you to set which eye image should be used when 
editing with the leading eye.

This is useful in scenarios where a beam-splitter rig was used 
during filming. In such a case, the leading eye is typically the 
non-reflected image.

Left: (Default) Indicates that the left eye image is the leading 
eye.

Right: Indicates that the right eye image is the leading eye.

Bin column Description
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Creating Stereoscopic Clips for Linked or Imported 
Media

When stereoscopic footage is imported from file or linked via AMA, only the contributing 
master clips are created. In order to use the stereoscopic functions in your Avid editing 
application, these master clips must be referenced from a stereoscopic clip. 

Before a stereoscopic clip can be created, certain S3D columns for the contributing master clips 
must be defined. This information may have been imported with the media, but you should verify 
that they have been applied appropriately.

• The S3D Channel of each master clip must be set according to its media content (i.e. left, 
right, over/under, side/side, or monoscopic).

• An S3D Group Name must exist for each master clip that will contribute to the stereoscopic 
clip. All master clips that feed into the stereoscopic clip must have the same group name. 
This can be done automatically by the application using the Populate function described 
later in this section.

You must use a unique group name for each stereoscopic clip that you intend to create.

• Optionally, you can also have an S3D Clip Name in any one of the contributing master clips. 
This name will be used as the stereoscopic clip name when it is created.

n Tip: If the clips are sorted into a separate bin for each eye, it makes it easier to multi-select all 
the clips and set the S3D channel. The clips can then be ordered by timecode to keep the clips in 
the same order in all the bins. This will make the stereoscopic clip creation process much more 
efficient.

For more information regarding the association between master clips and stereoscopic clips, see 
“What is a Stereoscopic Clip?” on page 51.

S3D Alignment Allows you to specify whether or not the media has already 
been aligned by a third-party application. Presently, this is 
just an indicator for the editor. There are no software 
functions associated with this field.

• None (Default) 

• Full: Indicates that media has been pre-aligned by an 
external application.

Bin column Description
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Setting the Stereoscopic Channel

If the files that you are importing do not contain metadata for the S3D Channel, you will need to 
add this information to the S3D column for the clips in the bin. 

To set the S3D channel:

1. Open the bin that contains the master clips you want to modify.

2. Display the S3D bin columns for the attributes you want to modify.

3. Select the clip that you want to modify (or use your operating system’s standard Ctrl+click 
and Shift+click selection methods to select multiple clips).

4. Select the S3D Channel column and choose the desired setting. Refer to “Bin Settings for 
Stereoscopic Clips” on page 53.

Setting the Stereoscopic Group Name

If the files that you are importing do not contain metadata for the S3D Group Name, you will 
need to add this information to their master clip attributes in the bin. Master clips with related 
content need to be given the same group name so that they can contribute to the same 
stereoscopic clip. You can request an auto-populate of the group name for all selected clips, or 
you can enter the group name yourself. When you manually enter the name, make sure that it is 
exactly the same for the associated clips. (This includes the use of upper and lower case letters, 
as well as extra spaces within or at either end of the name).

n If your S3D Group Name was automatically generated by an external application, you can 
override it by entering a more relevant name in the S3D Clip Name column. The name only 
needs to be set for one of the contributing master clips.

When assigning group names to selected clips, the following rules apply:

• A maximum of five master clips can contribute to each stereoscopic clip. There should be 
only one instance of each clip where the S3D Channel is set to either Left, Right, Side by 
Side, Over/Under or Monoscopic. 

The group name will be taken from the first clip name in the arrangement. In this example 
the first clip name is Take 1-.mov, so the group name becomes Take 1-.mov.s3d.
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You may name more than one group at a time. However, all selected clips for each group 
must be arranged in same pattern, and each group must have the same number of clips. 

To auto-populate the group name:

1. In the bin, select all the master clips originating from the same footage.

2. Right-click one of the selected clips and select Populate S3D Group Names automatically.

The Group name will be populated using the name of the first master clip in each group 
arrangement and appended with .s3D. 

Creating Stereoscopic Clips

When the master clips have the necessary stereoscopic attributes (channel and group name), you 
can select whole bins or individual master clips from which to create stereoscopic clips. Your 
editing application automatically creates a stereoscopic clip containing master clips with the 
same group name. In the bin, the resulting stereoscopic clips will have a different icon than the 
master clips.

n With the number of clips potentially doubling in quantity for stereoscopic projects, it’s a good 
practice to place your stereoscopic clips in a separate bin as they get created.

When you select the command to create stereoscopic clips, a dialog box displays to allow you to 
select specific bins, clips and other criteria for the master clips that will feed into the stereoscopic 
clip.

To create new stereoscopic clips:

1. Ensure that all the master clips have the required channel assignments and group name—see 
“Setting the Stereoscopic Channel” on page 57 and “Setting the Stereoscopic Group Name” 
on page 57.

2. Select all the master clips for which you want to create stereoscopic clips.

The example below contains master clips from two distinct groups. Each group has one left 
eye, right eye, over/under, side/side, and monoscopic master clip.
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n You may select clips from multiple bins.

If you want to use an entire bin, you can click on the Fast Menu icon in the bottom left corner to 
select the Create Stereoscopic clips command.

3. Right-click one of the selected clips and select Create Stereoscopic clips.

A dialog box will display to allow you to set more specific options.

4. Select an existing bin, or create a new destination bin for the stereoscopic clips that will be 
created.

5. Keep the default options or choose more specific criteria as described in “Create 
Stereoscopic Clips Dialog” on page 60.

Make sure that you carefully review all the options in this dialog box.

6. Click Ok to create the stereoscopic clips.

The Avid editing application analyses the master clips and creates a stereoscopic clip for 
each group name that it encounters. 
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Create Stereoscopic Clips Dialog

The following options are available when creating stereoscopic clips from master clips:

Option Description

Destination bin for created 
stereoscopic clips

Select an existing bin, or create a new bin in which to place the 
stereoscopic clips.

Consider clips from: When creating stereoscopic clips, the following options allow 
you to specify the scope of the search for contributors:

Selection in current bin Only create stereoscopic clips from the master clips that are 
selected in the current bin.

Selection in open bins Only create stereoscopic clips from the master clips that are 
currently selected in all open bins.

Current bin Scan all clips from the current bin, and create stereoscopic clips 
for each unique group name.

All open bins Scan all clips in all open bins, and create stereoscopic clips for 
each unique group name.

All bins in project Scan all clips in all bins in this project (even if they are not 
open), and create stereoscopic clips for each unique group name.

Retrieve default timecode from: Select the clip whose timecode will be used as the default for the 
stereoscopic clip. You have the choice of Left Eye, Right Eye, 
Over/Under, Side by Side or Monoscopic. If this channel does 
not exist, then the timecode from another contributing clip will 
be used.

The stereoscopic clip that is created will display this timecode in 
the bin. The Timecode window above the source or record 
viewers will also display this timecode as the default.

Name the new clips using: Sets the stereoscopic clip name based on the selected option.

S3D Clip Name The S3D Clip Name from the last master clip of all selected 
clips.

S3D Group Name The S3D Group Name from the contributing master clips.
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Updating Existing Stereoscopic Clips

There are a number of reasons why you may want to update your existing stereoscopic clips:

• to add or replace contributing master clips to the stereoscopic clips

• to change the existing settings for the stereoscopic clips

• to correct timing errors (temporal alignment) between the contributing clips 

These timing alterations or contributor changes take effect immediately and affect all sequences 
that use the stereoscopic clips.

To update stereoscopic clips:

1. Select all the stereoscopic clips that you want to update.

2. Right-click one of the selected clips and choose Update Stereoscopic clips.

n Alternatively, you may also open a bin containing these stereoscopic clips, and click on the Fast 
Menu icon in the bottom left corner to access this command.

Default TC Contributor The name of the contributing master clip whose timecode will 
be used as the default. The S3D suffix is appended to the name.

Create audio tracks in the clips 
from:

This option applies ONLY to audio coming in from video clip 
contributors. It will create corresponding audio tracks in the 
stereoscopic clips based on one of the selected options:

All contributing clips Uses audio from all video master clips feeding into the 
stereoscopic clip.

Default TC Contributor Uses audio only from the video master clip whose timecode is 
used as the default.

None of the clips Does not use the audio from the contributing video clips.

n If you have audio clip contributors, then these are automatically used in the stereoscopic clip.

Set S3D Leading Eye of 
stereoscopic clips to:

Set the leading eye to Left or Right. 

Sync contributing clips using: Synchronizes all clips contributing to the stereoscopic clip based 
on the option that you select—source timecode, first frame, 
inpoints, outpoints, or one of the auxiliary timecodes.

Create stereoscopic clips even if
they already exist in the
destination bin

If this option is selected, a new stereoscopic clip will be created 
even if a clip already exists for the group.

Option Description
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A dialog box will display to allow you to set more specific criteria for the clips that will be 
updated.

n Some settings that are not displayed here may be changed directly in the bin. Select the 
stereoscopic clip and the appropriate column to change the clip’s attributes.

3. Choose the specific criteria that you want to update as described in “Update Stereoscopic 
Clips Dialog” on page 62.

4. Click Ok to update the clips.

Update Stereoscopic Clips Dialog

The following options are available when updating stereoscopic clips from master clips:

Option Description

Update stereoscopic clips in: The following options allow you to specify the scope of the 
search for stereoscopic clips:

Selection in current bin Only update stereoscopic clips that are selected in the current 
bin.

Selection in open bins Only update stereoscopic clips that are currently selected in all 
open bins.

Current bin Update all stereoscopic clips from the current bin.

All open bins Update all stereoscopic clips in all open bins.

All bins in project Update all stereoscopic clips in all bins in this project (even if 
they are not open).

Search for new contributors in: When updating stereoscopic clips, the following options allow 
you to specify the scope of the search for contributors:
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Selection in current bin Only update stereoscopic clips from the master clips that are 
selected in the current bin.

Selection in open bins Only update stereoscopic clips from the master clips that are 
currently selected in all open bins.

Current bin Scan all clips from the current bin, and update stereoscopic 
clips.

All open bins Scan all clips in all open bins, and update stereoscopic clips.

All bins in project Scan all clips in all bins in this project (even if they are not 
open), and update stereoscopic clips.

Remove master clips that are not 
selected

If you select this option, then any master clips that are not 
selected will be removed from the stereoscopic clip. This allows 
you to replace the current contributors with a new selection.

n If a stereoscopic clip had contributors from other bins 
that were not part of the selection, then these master clips 
will also be removed.

Update default timecode 
contributor:

Select the contributing clip whose timecode will be used for the 
stereoscopic clip. You have the choice of Left Eye, Right Eye, 
Over/Under, Side by Side or Monoscopic.

The stereoscopic clip that is created will display this timecode in 
the bin. The Timecode window above the source or record 
viewers will also display this timecode as the default.

Sync new contributors using: Synchronizes any new clips contributing to the stereoscopic clip 
based on the option that you select—source timecode, first 
frame, inpoints, outpoints, or one of the auxiliary timecodes.

By default, any sync relationships previously established for 
existing contributing clips will be maintained.

Also sync existing contributors When this option is selected, all clips are synchronized with the 
selected option; even the ones that are already part of the 
stereoscopic clip. No attempt is made to preserve the sync 
relationships that may already have been established

Preserve start timecode of the
stereoscopic clips

Preserves the starting timecode of the stereoscopic clip.

Option Description
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Transforming Subclips into Stereoscopic 3D 
Subclips

If you have subclips that you would like to transform into stereoscopic subclips, there is a 
relatively simple process for adding the necessary stereoscopic 3D metadata.

n This process cannot be applied to the master clips in your bins. If the master clips also need to be 
transformed, you must first create subclips from them and replace the instances of those master 
clips on the timeline.

To transform your subclips to stereoscopic 3D subclips:

1. Open the bin and fill in (or merge using an ALE file) the stereoscopic fields of the 
masterclips that the subclips reference. 

Only the S3D Group name is mandatory. However, if you have information for the rest of the 
stereoscopic metadata, like the S3D Channel, S3D Inversion fields, S3D InversionR and 
S3D Eye Order, then they should be entered—see “Setting the Stereoscopic Group Name” 
on page 57.

2. Highlight all the subclips you want to transform in the bin.

3. Right-click in the bin, and select Transform subclips into stereoscopic clips.

Once the transformation is complete, you will have stereoscopic 3D clips with only one 
video contributor (i.e. one eye). These clips can be updated later on when you capture media 
from the other eye or other contributors.

Offset a S3D Channel relative to 
the others

Offsets the frames in the selected channel a specified number of 
frames. (This option cannot be used in conjunction with the 
Sync new contributors option. You can, however, first perform 
the sync and then reactivate this dialog box to perform the 
Offset.)

S3D Channel Choose between Left eye, Right eye, Over/Under, Side by side 
or monoscopic.

frame(s) Indicate the number of frames to be offset. You may enter 
negative values to offset a clip to the left.

Option Description



7 Monitoring Stereoscopic Footage

Stereoscopic media is acquired either in full frame or frame compatible format. When you create 
your project, you can choose the appropriate stereoscopic format at which you want to edit 
and/or output your media. The media is displayed according to the video layout set for the 
project, regardless of the format at which it was originally acquired. For example, if you have 
full frame media on disk, and your project is set to Side by Side, your application will set the 
clips on the timeline to a side by side layout for editing, effects processing, monitoring and 
output/export.

The project format can be changed at any time, so you can set it to side by side for the editing 
process, and then switch to full frame for the final output.

When monitoring stereoscopic footage, content can be displayed in different modes in each of 
the various application and external monitors. The viewing devices include:

• the Source and Record monitors in the Avid editing application

• a stereoscopic display device (3D-compatible monitor, 3D TV or projector) attached to your 
Avid system

Setting the Viewer Modes when working with 
Stereoscopic Media

The following viewing modes may be available depending on your system configuration (i.e. 
software only vs. Nitris hardware), and the viewing devices connected to your system. 

• Display either the left image or the right image only. 

This mode is useful when scanning through your bin footage and editing the rough cut.

• Display the left/right images in frame compatible format (either side by side, or over and 
under). 

This mode is useful when you want to compare the left and right images and make any 
spatial or color alignments.

Side/Side mode squeezes the left and right eye images one beside the other in a vertical split 
frame (left eye on the left). Your Avid editing application displays this content in a proxy 
resolution that uses one-half of the horizontal samples.
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Over/Under mode squeezes the left and right eye images one above the other in a horizontal 
split frame (left eye on top). Your Avid editing application displays this content in a proxy 
resolution that uses one-half of the image.

• Display the combined images in a blended mode to compare or check for differences 
between the left and right eyes.

• Display the images in stereoscopic 3D if you have the appropriate stereoscopic monitoring 
or projection equipment connected to your system.

Viewing Stereoscopic Material in the Source/Record Viewers

The source and record viewers on your system monitor can be set to display the left/right 
stereoscopic images together in a split frame, or to display either the left or the right eye image 
alone. Other stereoscopic view modes, which represent a blended version of the images, are also 
available.

n The stereo 3D view modes are not available if your Stereosocopic project setting is set to either 
Off, Left, Right, or Leading. This is because your Avid application is only set to use a single eye.

To select a stereoscopic view for playback in the monitors:

1. Right-click in a monitor, and select S3D View Mode.

2. Select one of the following from the list:

Option Description

Mix Displays a 50/50 blend of both the left and right eye images.

Difference Displays a blend of both left and right eyes, and highlights the difference 
between the two. Embossed areas show the differences, while gray pixels 
represent no differences.

Frame Compatible Displays both the left and right eye images as dictated by the project 
settings (side/side or over/under).

Mono Displays only one of the stereoscopic images.

Left Displays only the left eye image.

Right Displays only the right eye image.

Leading eye Displays only the image set as the leading eye on the stereoscopic clip.

Anaglyph Displays the image with the selected color highlights only where there are 
differences in the left and right eye. The pixels in each eye image can be 
mapped to any of the following color options: 

Red-Cyan Uses red for the left eye and cyan for the right.
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n If you are operating on a software-only system, you may switch your monitor to full-screen 
playback just to see the resulting video image—see “Viewing Stereoscopic Material in 
Full-Screen Playback Mode” on page 67. There are also low-cost stereoscopic 3D-compatible 
monitors (such as the NVIDIA 3D Vision) that you can connect to your system to view full-screen 
playback in 3D.

Viewing Stereoscopic Material in Full-Screen Playback Mode

On a software-only system (i.e. with no Avid input/ouput hardware), you can use either your 
system monitor or your external stereo 3D-compatible monitor to view the sequence in 
full-screen playback mode.

You can also connect to a TV or projector directly from the DVI port on your graphics card. This 
allows you to view frame compatible media in stereo 3D, when you set the appropriate display 
mode on your TV/projector.

Green-Magenta Uses green for the left eye and magenta for the right.

Amber-Blue Uses amber for the left eye and blue for the right.

 B/W Anaglyph Displays a monochrome image in with color highlights only where there 
are differences in the left and right eye. The pixels in each eye image can 
be mapped to the following color options:

B/W Red-Cyan Uses red for the left eye and cyan for the right.

B/W Green-Magenta Uses green for the left eye and magenta for the right.

Checkerboard When this option is selected, your Avid editing application displays the 
left and the right images simultaneously for stereoscopic viewing. The 
term “checkerboard” refers to the way in which blocks of the left and right 
images are displayed for stereoscopic viewing.

1 x 1 Each block size is approximately 1 by 1 pixel.

10 x 10 Each block size is approximately 10 by 10 pixels.

20 x 20 Each block size is approximately 20 by 20 pixels.

50 x 50 Each block size is approximately 50 by 50 pixels.

100 x 100 Each block size is approximately 100 by 100 pixels.

Compare Compares the left and right eye images using a diagonal split screen. You 
can set the comparison mode to 25, 50, or 75%.

Option Description
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n On a two-dimensional monitor, the left and right images are superimposed and slightly offset. 
This results in a ghosted or blurred look. On a stereoscopic display with appropriate 3D glasses, 
the image will be in 3D.

To select a stereoscopic view for full-screen playback (on a software-only system):

1. In the Settings tab of the Project window, double-click Full-Screen Playback.

The Full-Screen Playback Settings dialog box opens.

2. Select one of the following from the S3D View list:

Option Description

Off Displays the image as dictated by the stereoscopic project settings.

Mix Displays a 50/50 blend of both the left and right eye images.

Difference Displays a blend of both left and right eyes, and highlights the difference 
between the two. Differences are indicated with grey pixels.

Frame Compatible Displays both the left and right eye images as dictated by the project 
settings (side/side or over/under).

Full Frame Only available with a stereo 3D-compatible display. Projects the left and 
right images so that you can view the content in stereoscopic 3D.

Mono Displays only one of the stereoscopic images.

Left Displays only the left eye image.

Right Displays only the right eye image.

Leading eye Displays only the image set as the leading eye on the master clip.

Anaglyph Displays a blended image with pixels for each eye corresponding to one of 
the following color options. 

Red-Cyan Uses red for the left eye and cyan for the right.

Green-Magenta Uses green for the left eye and magenta for the right.

Amber-Blue Uses amber for the left eye and blue for the right.

 B/W Anaglyph Displays a blended monochrome image with color highlights only where 
there are differences in the left and right eye. The pixels in each eye image 
can be mapped to the following color options:

B/W Red-Cyan Shows differences in red and cyan for the left and right eyes respectively.

B/W Green-Magenta Shows differences in green and magenta for the left and right eyes 
respectively.
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3. Select one of the following from the S3D Overlay list:

4. Click OK.

When you load a clip, the Composer window or the full-screen playback display uses the 
view mode you selected.

To view full screen stereoscopic playback:

1. In the Full Screen Playback Settings dialog, set the S3D View to Full Frame.

2. Load a sequence with stereoscopic material into the record monitor.

Checkerboard When this option is selected, your Avid editing application displays the 
left and the right images simultaneously for stereoscopic viewing. The 
term “checkerboard” refers to the way in which blocks of the left and right 
images are displayed for stereoscopic viewing. Blocks are approximately n 
x n pixels in size.

Compare Compares the left and right eye images using a diagonal split screen. You 
can set the comparison mode to 25, 50, or 75%.

Follow Source or 
Record

Displays stereoscopic material based on the viewer mode selected for the 
Source/Record monitors. If the source/record monitors are set to two 
different view modes, then it uses the monitor that is highlighted and 
currently active.

Option Description

Option Description

Off Does not display any disparity guides on the viewer.

The following options display disparity guides on the viewer so that you 
can see the depth budget limits when adjusting the separation between 
your stereo 3D images. The guides for Parallax are based on the project’s 
S3D settings (set from the Project window, Settings tab). For a better 
understanding of parallax and the disparity guides, see “Setting the Depth 
Budget and Stereoscopic Dimensions” on page 76.

Parallax Near Displays green guides that show the limits for objects that will appear in 
front of the screen plane.

Parallax Far Displays blue guides that show the limits for objects that will appear 
behind the screen plane.

Parallax Near/Far Displays both guides (green and blue) that show the limits for objects that 
will appear in front and behind the screen plane.
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3. Turn on your 3D glasses.

The video output will be routed to your 3D-compatible display, and the emitter should glow 
bright green. 

Viewing Stereoscopic Material on a Avid Nitris System

A stereoscopic 3D TV or projector can be connected to your Avid system via the Avid Nitris 
input/output hardware. Refer to “Stereoscopic 3D Configuration with Avid Nitris Hardware” on 
page 22.

n Refer to the vendor’s documentation for setting the appropriate view mode on your display.

The format displayed on the output device is determined by the project settings. You can, 
however, set your monitor to view this content in a different mode. For example, you can work 
with a frame compatible format in the editing application and still view the resulting images in 
stereoscopic 3D on your connected display device.

c The S3D view mode that you select here will override the stereoscopic project setting and 
will also be used for output of your sequence when you do a digital cut.

To select a stereoscopic view for your 3D TV or Projector:

1. Select Tools > Video Output Tool.
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2. Select one of the following from the S3D View list:

Option Description

Follow Project Displays the image as dictated by the stereoscopic project settings.

Mix Displays a 50/50 blend of both the left and right eye images.

Difference Displays a blend of both left and right eyes, and highlights the 
difference between the two. Differences are indicated with grey 
pixels.

Frame Compatible Displays both the left and right eye images at half resolution as 
dictated by the project settings (side/side or over/under).

Full Frame Displays both the left and right images at full resolution for 
viewing in stereoscopic 3D.

Mono Displays only one of the stereoscopic images.

Left Displays only the left eye image.

Right Displays only the right eye image.

Leading eye Displays only the image set as the leading eye on the master clip.

Anaglyph Displays a blended image with pixels for each eye corresponding to 
one of the following color options. 

Red-Cyan Uses red for the left eye and cyan for the right.

Green-Magenta Uses green for the left eye and magenta for the right.

Amber-Blue Uses amber for the left eye and blue for the right.

 B/W Anaglyph Displays a blended monochrome image with color highlights only 
where there are differences in the left and right eye. The pixels in 
each eye image can be mapped to the following color options:

B/W Red-Cyan Shows differences in red and cyan for the left and right eyes 
respectively.

B/W 
Green-Magenta

Shows differences in green and magenta for the left and right eyes 
respectively.

Checkerboard When this option is selected, your Avid editing application displays 
the left and the right images simultaneously for stereoscopic 
viewing. The term “checkerboard” refers to the way in which 
blocks of the left and right images are displayed for stereoscopic 
viewing. Blocks are approximately n x n pixels in size.
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3. Select one of the following from the S3D Overlay list:

4. Click OK.

When you load a clip, the Composer window or the full-screen playback display uses the 
view type you selected.

Compare Compares the left and right eye images using a diagonal split 
screen. You can set the comparison mode to 25, 50, or 75%.

Follow S/R Displays stereoscopic material based on the viewer mode selected 
for the Source/Record viewers. If the source/record viewers are set 
to two different view modes, then it uses the viewer that is 
highlighted and currently active.

Option Description

Option Description

Off Does not display any disparity guides on the viewer.

The following options display disparity guides on the viewer so that 
you can see the depth budget limits when adjusting the separation 
between your stereo 3D images. The guides for Parallax are based on 
the project’s S3D settings (set from the Project window, Settings tab). 
For a better understanding of parallax and the disparity guides, see 
“Setting the Depth Budget and Stereoscopic Dimensions” on 
page 76.

Parallax Near Displays green guides that show the limits for objects that will appear 
in front of the screen plane.

Parallax Far Displays blue guides that show the limits for objects that will appear 
behind the screen plane.

Parallax Near/Far Displays both guides (green and blue) that show the limits for objects 
that will appear in front and behind the screen plane.

Follow S/R Displays stereoscopic material based on the overlay mode selected 
for the Source/Record viewers. If the source/record viewers are set to 
two different view modes, then it uses the viewer that is highlighted 
and currently active.
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Customizing your Viewers and Timeline to View 
Stereoscopic Content

The Command Palette below shows the various stereoscopic view mode options that can be 
mapped to buttons that display your stereoscopic content on each source/record monitor, as well 
as on the timeline. 

To access the S3D command palette:

1. Select Tools > Command Palette.

2. Select the Stereo tab.

3. For information on adding these buttons to your viewers or timeline, see “Mapping 
User-Selectable Buttons” in the online help.

n When you add the Stereo Menu button to your viewer, it will provide you a full menu of Stereo 3D 
view commands. To access the menu, use the right-click on your mouse.
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Example of viewer customized with buttons for stereoscopic monitoring

Stereo 3D buttons



8 Making Corrections to Stereoscopic 
Clips

Some third-party applications can do the temporal, spatial, vergence, and colorimetric alignment 
of stereoscopic footage as part of the dailies creation process. If you are using media that has 
already been corrected, it is unlikely that you will need to make further changes. 

If necessary, the Avid editing application does include a number of tools that you can use to 
make corrections to stereoscopic clips before they are used on the timeline. The eye orientation, 
spatial or temporal alignment, and colorimetric properties can be corrected directly on 
stereoscopic clips in the bin. By fixing these clips at the source level you ensure the integrity of 
the images and data when they are used downstream in the editing pipeline. It also avoids editors 
having to make repeated corrections to the stereoscopic clips after they are placed on the 
timeline.

n Tip: Avid recommends that you apply the source-side corrections to the full length stereoscopic 
clips, before you begin creating any subclips.

Some corrections can be made simply by changing certain stereoscopic properties, while others 
require that you apply a source-side effect. Here are the some of the stereoscopic issues that you 
can correct:

Errors to be corrected Method

If the eyes need to be geometrically aligned, or the 
disparity between the two eyes needs to be adjusted. 

Apply the Spatial Alignment Effect—see 
“Fixing Spatial or Color Alignment 
Errors” on page 78.

If you need to match and normalize the colors between 
the eyes.

Apply the Color Alignment Effect to 
correct each eye individually—see “Fixing 
Spatial or Color Alignment Errors” on 
page 78.

If one of the eyes is not synchronized in time with the 
other.

Right-click on the stereoscopic clip and 
select Update Stereoscopic Clips. Offset 
the frames in the appropriate S3D channel 
to match with the others—see “Update 
Stereoscopic Clips Dialog” on page 62.
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After applying source-side effects to stereoscopic clips, you have the capability to push all the 
changes in the bin to wherever they are used in a selected sequence—see “Updating a Sequence 
with Stereoscopic Clip Corrections” on page 82.

Setting the Depth Budget and Stereoscopic 
Dimensions

Use the following settings to enter the depth budget for your project so that your Avid editing 
application can provide you with parallax guides for the adjustment of vergence points and depth 
in your stereoscopic 3D images. These options are available for the overall project and not on a 
shot by shot basis. You should also enter the dimensions according to the projection format of the 
display for the final deliverable.

The depth budget is the maximum recommended amount of 3D depth in front of and behind the 
display screen. The amount of depth budget depends on the average viewing distance from the 
screen, the size of the screen, and the resolution of the projected image. These depth budget 
limits are normally defined as part of the deliverables from the broadcaster or studio.

To enter the S3D Settings for the project:

1. From the Project window, select the Settings tab.

2. Double-click S3D.

If the left and right eyes are swapped. For full frame clips, change the S3D 
Channel for the left and right eye master 
clips. 

For frame compatible clips, change the 
S3D Eye Order setting.

See “Bin Settings for Stereoscopic Clips” 
on page 53.

If the image coming from the camera is inverted (e.g. in 
the case of a beamsplitter rig configuration).

For full frame clips, change the S3D 
Inversion for either the left and right eye 
master clips. 

For frame compatible clips, change the 
InversionR setting to flip the right side of 
image either horizontally or vertically, or 
both.

See “Bin Settings for Stereoscopic Clips” 
on page 53.

Errors to be corrected Method
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The S3D Settings dialog displays.

3. Enter the necessary parameters as described below, and click Ok.

S3D Settings

SCREEN PLANE

DEPTH LIMIT: FAR
(POSITIVE SPACE)

DEPTH LIMIT: NEAR
(NEGATIVE SPACE)

INTEROCULAR DISTANCE
(EYE SEPARATION)

CONVERGENCE POINT: NEAR

CONVERGENCE POINT: FAR

LEFTRIGHT

LEFT EYE RIGHT EYE

RIGHTLEFT

VIEWING
DISTANCE

Option Description

Unit System Choose between Imperial or Metric units of measure.

Viewing Distance Enter the average distance between the audience and the screen.

Screen Width Enter the width of the screen for which the final output will be 
delivered.

Raster Resolution Enter the resolution at which the final output will be projected.

Eye Separation Set the average interocular distance between human eyes (the 
default is 6.35 cm).

Depth Limit Near Enter the depth budget available in front of the screen. This is 
always a negative value.

Depth Limit Far Enter the depth budget available behind the screen. This is 
always a positive value. 

Parallax Near/Far These distances are automatically calculated as a percentage of 
the near and far depth limits. If you set the drop-down button to 
manual, you may override the calculated settings.
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Fixing Spatial or Color Alignment Errors

Spatial or color alignment errors can be adjusted by applying source-side effects directly to the 
stereoscopic clips in the bins. The stereoscopic clip must be loaded into the Source monitor so 
that you can apply the necessary adjustments while in Stereo Correction mode. This stereoscopic 
clip must have the same frame rate as the project frame rate in order for you to perform the 
source side alignments.

n On the timeline, a tiny green dot will display on stereoscopic clips that have a source-side effect 
applied. Also, if a source-side effect is not playable in real-time, a red bar will appear over the 
clip to indicate that it requires rendering.

To apply a source-side effect to a stereoscopic clip:

1. Select a stereoscopic clip in the bin and load it in the Source monitor.

2. Click the Toggle Source/Record in Timeline button.

By default, the Timeline displays only the available tracks for the source material. Both the 
button and the position indicator turn green to indicate that you are viewing source material.

3. Click on the Stereo Correction Mode button in the toolbar on the left. 

n This button is only available if your project setting is set to Stereoscopic.

Three viewers are available in this mode—Left, Output, and Right. The Output monitor 
(center viewer) shows both eyes side by side so that you can closely compare both images.

By default, the Color Correction effect is displayed, but you can also open the Spatial 
Alignment effect in order to correct geometrical errors. Open this effect by clicking the Add 
Spatial Correction Effect button located just under the Output monitor.

As a rule, apply your color correction fixes before you adjust the spatial alignment.
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- To fix color alignment issues between the eyes—see “Color Correcting Stereoscopic 
Clips (Source-Side)” on page 79.

- To fix spatial alignment issues—see “Fixing Spatial Alignment on Stereoscopic Clips 
(Source-Side)” on page 79.

Color Correcting Stereoscopic Clips (Source-Side)

There are often cases where you need to correct color differences across both eyes. These errors 
can be significantly more pronounced when using a beamsplitter rig. The Source-side Color 
Alignment effect allows you to match and normalize the colors between the eyes. This effect is 
applied directly on the clip in the bin so that the corrections are applied at source.

n If you have an Avid Artist Color controller and have installed the EuControl application, you can 
select the EUCON™ (Extended User Control) device as your media controller. Then you can use 
the device for color correction edits with your stereoscopic clips. For more information, see 
"Using Avid Artist Color" in the What's New Guide for your Avid editing application.

To color correct the eyes:

1. Load the stereoscopic clip into the Source monitor and invoke the Stereo Correction mode as 
directed in “Fixing Spatial or Color Alignment Errors” on page 78.

2. Select the viewer representing the eye that you want to correct.

3. Use the color wheels to adjust the color. 

For general information on color correcting your images, refer to “Performing Color 
Corrections” in the Help.

4. After the necessary corrections are made, click on the Toggle Source/Record in Timeline 
button to exit the Stereo Correction mode.

Fixing Spatial Alignment on Stereoscopic Clips (Source-Side)

If there are any vertical or rotational alignments that need to be done on the right and left eyes, 
you can apply the Source-side Spatial Alignment Effect to make the corrections directly to the 
stereoscopic clip in the bin.

This effect may also be used if you need to crop out edge violations or adjust disparity between 
the two eyes. 
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To load the effect:

1. If you are applying this effect on the source clip in the bin, load the stereoscopic clip into the 
Source monitor and invoke the Stereo Correction mode as directed in “Fixing Spatial or 
Color Alignment Errors” on page 78.

If you are applying this effect on a clip that is already on the timeline, see “Applying Effects 
to Stereoscopic Clips on the Timeline” on page 90.

n The Color Correction view will remain open. You may minimize this view, but do not close it as 
doing so will close the Stereo Correction mode altogether.

2. Select the Output viewer and click the Spatial Correction button in the viewer toolbar to 
open the Spatial Correction Effect editor.

To fix spatial alignment:

1. In the Effect Editor, expand the S3D Spatial Alignment group to view the parameters that 
allow you to adjust the images. 

2. Expand the Alignment group and the respective Right and Left eye groups.

3. Select the necessary options under the Alignment group to move, scale, rotate or shear the 
images—see “S3D Spatial Alignment Effect Editor Reference” on page 81.



Fixing Spatial or Color Alignment Errors

87

4. If you need to converge or diverge the two eyes, expand the Vergence group and see 
“Adjusting the Convergence Point of Stereo Images” on page 92.

5. If you need to crop the two eyes—see “Cropping Out Unwanted Areas in Stereoscopic 
Clips” on page 98.

6. Moving the images may result in black areas appearing around the edges. You can expand 
the Zoom group and select the Auto-Zoom option which scales the images to crop out the 
black areas.

You can also use the Zoom slider to manually scale the image.

7. After the necessary corrections are made, click on the Toggle Source/Record in Timeline 
button to exit the Stereo Correction mode.

S3D Spatial Alignment Effect Editor Reference

The S3D Spatial Alignment effect contains alignment tools with translation, scaling, shearing 
and rotational controls. It also includes the Vergence and Floating Window effects that allow you 
to adjust the disparity between the left and right eye images.

Use Alt + click to reset each of the controls to zero.

Option Description

All alignment controls are available for either the left, right, or both eyes:

Left eye Adjust only the left eye.

Right eye Adjust only the right eye.

Global Adjust both the left and right eyes 
simultaneously

The following operations can be performed for each eye:

Translation Repositions the image along X and Y axes.

X Move the slider either right or left to move the 
image horizontally. 

Y Move the slider either right or left to move the 
image vertically. 

Center Allows you to reposition the center point of the 
image by moving the X and Y sliders. All 
alignment operations will be based on this 
center point.
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You can set keyframes at certain points in time to animate the changes to each image—see 
“Manipulating Advanced Keyframes” in the online Help.

Updating a Sequence with Stereoscopic Clip 
Corrections

Source-side effects can only be applied to clips in a bin. After applying a source-side effect to a 
stereoscopic clip, you have the capability to push all changes in the bin to the same clips on the 
timeline.

n The original master clips feeding into the stereoscopic clip are not affected. The source-side 
effect is only applied to the stereoscopic clip. 

To update a sequence on the timeline with any source-side corrections:

t In the bin, right-click on the sequence that you want to update, and select Refresh Sequence 
> Stereo Correction Effects.

Scaling Scales the image.

X Move the slider either right or left to scale the 
image horizontally. 

Y Move the slider either right or left to scale the 
image vertically. 

Fixed Aspect Scales the image proportionally.

Shearing Skews the image vertically or horizontally.

Rotation Rotates the image.

X Move the slider either right or left to rotate the 
image around the X axis. Maximum rotation is 
20%. 

Y Move the slider either right or left to rotate the 
image around the Y axis. Maximum rotation is 
20%. 

Z Move the slider either right or left to rotate the 
image around the Z axis. Maximum rotation is 
20%. 

Option Description
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All source-side corrections that you have applied to the stereoscopic clips will be pushed to 
the sequence.
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9 Editing Stereoscopic Clips on the 
Timeline

The project format settings dictate the way in which the application handles material that is 
placed on the Timeline for editing. When you edit the stereoscopic clips on the Timeline, the 
application automatically reformats them according to the project settings. For example, if you 
drop a full frame stereoscopic clip on the Timeline where the project settings are set to Side by 
Side, the two separate left and right streams are automatically combined to produce a frame 
compatible side by side format. 

Similarly, while editing the rough cut, you can choose to work with a single eye in the display 
monitors. This will enable you to work with your stereoscopic clips as you would in a standard 
monoscopic sequence. Media will only be rendered, transcoded or output to tape for one 
eye—see “Editing Stereoscopic Clips with the Leading Eye” on page 87.

Similarly, you can mix clips with different frame rates and color space settings on the Timeline. 
All reformatting is done in real-time during playback.

You can change the stereoscopic format at any time in the Format tab of the Project window. You 
can also switch your project between mono and stereoscopic. The Avid editing application will 
adjust accordingly as described in the following scenarios:

• If you switch the Stereoscopic option Off for your project, any stereoscopic clips in the 
Timeline will be treated as if they are mono clips, and only the leading eye image will be 
used.

Any effects applied to the stereoscopic clips will remain and will be applied only to the 
leading eye image. However, any settings that apply to both images (such as convergence 
settings), will be disabled.

• If you use mono clips in a stereoscopic project, the Timeline will display any mono clips as 
if they are stereoscopic clips, using identical images for the left and right eyes.

Also note that despite the project format settings, the source and record monitors (and other 
display devices) can be set differently to view your clips. For more information, see “Monitoring 
Stereoscopic Footage” on page 65.
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Editing Functions that Apply to Stereoscopic Clips

When stereoscopic clips are placed on the Timeline, the objects do not look any different than 
standard monoscopic clips. They can be edited in the usual manner with a few specific 
stereoscopic features that are noted below:

n It is important that you understand the stereoscopic clip model before you begin editing your 
footage—see “What is a Stereoscopic Clip?” on page 51.

Function Description

Audio When you create stereoscopic clips, the audio tracks from the source master 
clips are automatically recreated on the stereoscopic clip. In the case of a full 
frame clip, the tracks from the left eye are listed first, followed by the tracks 
from the right eye.

Any stereo audio groupings are preserved.

Consolidate When you select a stereoscopic clip, stereoscopic subclip, or sequence in the 
bin, the application finds the media used by these clips or sequence, and 
makes copies of the media on the target drive that you specify. 

Since stereoscopic clips may have various contributing master clips (left, 
right, side by side, etc.), the required portions of the media from all 
contributors is copied.

Decompose New stereoscopic and contributing master clips will be created for all clips 
used in the selected sequence. As usual, the new clips will be based only on 
the lengths edited into a sequence.

Delete If you select a stereoscopic clip for deletion, you will have the option to 
delete the stereoscopic clip, and/or the media associated with the 
contributing master clips. The contributing master clips themselves are not 
deleted.

Reveal file If you select a stereoscopic clip, it will reveal all media associated with the 
contributing master clips. This includes the left eye, right eye, frame 
compatible media, and all resolutions.
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Editing Stereoscopic Clips with the Leading Eye

A common approach when editing is to do most of your work while viewing either the left or the 
right image. This saves time when rendering of effects, as well as space on your system for 
storage of the media. Your facility might have common standards for which image to use while 
editing full frame stereoscopic material. 

Subclips You can create subclips of stereoscopic clips in the same way as standard 
clips. When they are created, they have the S3D.Sub extension. 

Stereoscopic subclips reference the contributing master clips, and the master 
clips point to the media. Therefore, when you delete a subclip, it does not 
delete any media.

n Tip: Before you begin creating any subclips, Avid recommends that 
you first merge any additional metadata that applies to your master 
clips, and apply necessary source-side corrections to the full length 
clips.

Mixdown The result of the mixdown will be in the same S3D format as the project. For 
instance, if your project is set to Side by Side, you will end up with a Side by 
Side master clip accompanied with a S3D clip that references it. Similarly, 
for full frame, you will get a left and a right master clip, along with a S3D 
clip.

Render When you render your effects, media is generated based on the stereoscopic 
format selected in the project settings. For example, if you are working in 
full frame, two full frame precomputes will be generated (one for each eye). 
Similarly, if your project is set to Left eye only, then only the left eye 
precompute is generated.

After precomputes are generated for the clips, and you change the 
stereoscopic format, then only media that matches the current project format 
will be displayed. If no matching media can be found, the effect will show as 
unrendered.

Transcode The stereoscopic project setting is not used in case of transcodes. When you 
transcode your sterescopic clips, each contributing master clip is transcoded 
individually. Therefore transcoding a side by side clip will always produce 
side by side media regardless of the project setting. 

Function Description
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You can indicate which of the clips contributing to the stereoscopic clip will be used as the 
leading eye. Typically, this is the non-reflected or “hero eye” from the camera rig. The leading 
eye is set in the S3D Leading Eye column in the bin, and can be set on a clip by clip basis. When 
you set the stereoscopic project setting to Leading Eye, the application automatically uses the 
clips marked as the leading eye. 

To use the leading eye for all editing functions:

1. In the bin view, select the Format tab.

2. Set the Stereoscopic option to Leading Eye.

By default, the left eye is the leading eye. To set the leading eye to a different clip, you must 
change the master clips’ leading eye attribute—see “Bin Settings for Stereoscopic Clips” on 
page 53.

For any full frame stereoscopic (S3D) clips placed on the Timeline, the leading eye will be 
used for editing. 

This also means that only media for the left eye will be generated for any rendered or 
transcoded clips. Before you generate your final output for stereoscopic delivery, you must 
switch back to full frame and re-render your Timeline.



10 Applying Effects to Stereoscopic Clips 

Effects in your Avid editing application are available under a number of groupings, and can be 
applied in different ways. All these effects can be applied to stereoscopic segments or transitions 
just as they would with standard sequences; and they can be applied to both full frame or frame 
compatible media. 

By default, any effects applied to stereoscopic clips will be applied to both eyes. If necessary, 
you can change the stereoscopic setting in the Effects Editor to apply it to just one of the eyes. 
The stereoscopic setting is available for all effects, including third-party AVX2 effects.

Some effects, like the Title tool, have specific stereoscopic settings to adjust the parallax between 
the two eyes. For more information, see “Adjusting the Convergence Point of Stereo Images” on 
page 92. There are also other stereoscopic-specific effects that are available just to handle issues 
in stereoscopic projects. These effects can be found under the S3D group in the Effect Palette.

The information in this section describes certain techniques for applying effects to stereoscopic 
clips. For general information on applying effects, refer to “Effects Concepts and Settings” in the 
Help.

Effect Description

Stereo Floating Window Allows you to crop out an unwanted area of either the left or right 
eye image. For example, cropping out edge violations that are 
visible in one eye but not the other.

Stereo Vergence Allows you to adjust the disparity between the two eyes.

Stereo Depth Transition When transitioning from one clip to another, this effect allows you 
to adjust the depth on the outgoing and incoming clips for a 
seamless transition.

Stereo Spatial Alignment Allows you to realign left and right eye images using translation, 
scaling, shearing or rotational controls.

This effect contains alignment tools as well as the Vergence and 
Floating Window effects.
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Applying Effects to Stereoscopic Clips on the 
Timeline

When working with stereoscopic material, you can control whether an effect or color correction 
applies to just one of the eye images, or to both of them.

In most cases, you want the effect or color correction to apply to both of the eye images. For 
example, if you apply a Dissolve effect between two stereoscopic segments, you want the effect 
to apply to both eyes with the same position and duration values. 

In some situations, you might want to apply an effect or a color correction to the image from one 
eye only. (For example, you might use Scratch Removal to remove a scratch on the left eye 
image) To achieve these kinds of effects, apply the effect to Left Only or to Right Only, 
depending on which eye image requires adjustment.

In cases where one eye needs different adjustments than the other, you will need to apply the 
effect twice—one on the left eye and another on the right eye. This allows you to set different 
parameters for each eye.

n You can stack multiple effects on a clip by pressing the ALT key as you drag an effect from the 
palette to the clip on the timeline. Keep the Effect Editor open so that you can see all the effects 
applied on the clip.

Remember that some effects are not appropriate for stereoscopic material, or require careful use 
and a good understanding of how stereoscopic images work. For example, some effects can 
change the amount of separation between the two eye images and disrupt the three-dimensional 
look.

In most cases, it’s best to set the Composer views to show just one eye. This gives you a better 
perspective when applying your effect, especially in cases where you are painting or adding text 
on an image.

To apply an effect to a stereoscopic segment:

1. Select Tools > Effect Palette. 

2. Choose the appropriate effect group. 

A list of effects will display on the right.

3. Select the effect that you want to apply, drag it over the transition or segment in the 
Timeline, and release the mouse button.

4. Open the Effect Editor by selecting Tools > Effect Editor. 

All the effect parameters will display.
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When you apply standard effects within a stereoscopic project, the Stereoscopic group of 
parameters will display to allow you to choose if you want to apply the effect to one or both 
eyes. (These parameters are not available for effects from the S3D group as it is assumed 
that S3D effects are always applied to both eyes.)

5. Adjust all parameters as required.

The effect will be applied as specified.

Some effects are playable immediately in real-time while others may need rendering before 
you can view the results. In the case of stereoscopic material, changing the view mode will 
not require you to re-render your effect. For example, if you switch your viewer mode from 
side/side to over/under, the application will simply reposition the images in the viewer with 
the rendered effect.

If your stereoscopic project is set to Full Frame format, two precompute files are created for 
each effect when you render your effects.

Stereoscopic options

Apply effect on BOTH eyes Default. Applies all the parameters to both eyes. 

Apply effect on LEFT eye ONLY Applies all the parameters to the left eye only.

Apply effect on RIGHT eye ONLY Applies all the parameters to the right eye only.
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Adjusting the Convergence Point of Stereo Images

Stereoscopic cameras have at least two view points which simulate the human eyes. In the Avid 
editing application, images from these two views are simulated to create the illusion of a 
three-dimensional picture. The horizontal distance between corresponding points in the left and 
right images is known as parallax, and is key to reproducing the stereoscopic depth effect.

In a stereoscopic 3D image, objects can appear on the screen plane, in front of the screen plane, 
or behind the screen plane. Objects that fall on the screen plane have no disparity between the 
left and right images, and thus will be perfectly in line. 

Objects that are further in the background, have a convergence point that falls behind the screen 
plane. This means that these particular objects in the image are further apart from each other.

Any objects that appear to be coming out of the screen toward the viewer actually have a 
convergence point that falls in front of the screen plane. These objects in the image are further 
apart from each other but in the inverse direction from those behind the screen. Therefore the 
objects in the left image will appear further to the right, and the objects in right image will appear 
further to the left. (Refer to the illustration below that shows the actual placement of these 
images on the screen plane.)

Objects in front of the screen are referred to as being in negative space, and objects behind the 
screen are in positive space. 
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In order to produce a coherent image, you may need to adjust the convergence point to place the 
desired object at the appropriate position in relation to the screen plane. You also need to respect 
the near and far limits to keep the overall viewing experience comfortable.

To allow the editing application to provide you with guidelines on keeping your images within 
the proper depth budget, you need to provide certain parameters based on the viewing 
dimensions of the final output. These need to be entered in the S3D settings so that the Avid 
editing application can be calibrated for any depth adjustments that you need to make in your 
overall sequence.

To enter the S3D Settings for the project:

1. From the Project window, select the Settings tab.

2. Double-click S3D Settings.

The S3D Settings dialog displays. Enter the necessary parameters as described in “Setting 
the Depth Budget and Stereoscopic Dimensions” on page 76.

To adjust the distance between eyes using the vergence controls:

1. Select the clip on the timeline that requires depth grading.

2. From the Tools menu, select Effect Palette.

3. From the left side of the Effect Palette window, select S3D.

A list of stereoscopic effects is displayed on the right.

SCREEN PLANE

DEPTH LIMIT: FAR
(POSITIVE SPACE)

DEPTH LIMIT: NEAR
(NEGATIVE SPACE)

INTEROCULAR DISTANCE
(EYE SEPARATION)

CONVERGENCE POINT: NEAR

CONVERGENCE POINT: FAR

LEFTRIGHT

LEFT EYE RIGHT EYE

RIGHTLEFT

VIEWING
DISTANCE
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4. Select the S3D Vergence effect.

The effect is applied to the selected stereoscopic clip on the timeline.

n Other effects such as Title tool, Matte key and 3D Warp also have vergence controls.

5. Select Tools > Effect Editor to open the S3D Vergence effect.

For parameter descriptions, see “S3D Vergence Effect Editor Reference” on page 95.

6. Right-click on the Record or FSP viewer and set the S3D mode to Mix, Difference, or 
Anaglyph. 

This allows you to see the overlap between objects more clearly.

7. Right-click on the Record or FSP viewer and set the S3D Overlay Mode to Parallax Near, 
Parallax Far or both.

This displays the parallax guides on the viewer so that you can see the maximum depth 
allowed for your 3D images. 
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The depth budget for objects in front of the screen (near) is the region between two adjacent 
green lines. The depth budget for objects behind the screen (far) is the region between two 
adjacent blue lines. In order not to exceed the depth limits, the overlapping region between 
the two objects in the image must fall within the guides. 

Keep in mind that the guides are set for the overall 3D space of a sequence, and they are 
useful for longer 3D scenes where you need to minimize any viewer discomfort. Therefore, 
you may have more flexibility in the depth budget from one shot to the next (for example, 
when the camera zooms in or zooms far out). In some cases, where you want to heighten the 
impact of a 3D effect for a very brief length of time, you may exceed the suggested depth 
budget.

n If the lines are very close together, you may need to zoom in to the application viewer to make 
vergence adjustments.

8. Use the Stereo Vergence slider to converge or diverge the two images.

9. If moving the images causes black areas to appear along the sides, then you can select the 
Auto-Zoom option which scales the images to crop out the black areas.

You can also deselect the Auto-Zoom and use the Zoom slider to manually scale the image.

S3D Vergence Effect Editor Reference

The S3D Vergence effect contains alignment tools that allow you to adjust the disparity between 
the left and right eye images.

Parallax Guides

Depth Budget

Parallax of
Left and Right images
exceeds the depth budget

Parallax of
Left and Right images
within the depth budget

Depth Budget
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You can set keyframes at certain points in time to animate the changes to each image—see 
“Manipulating Advanced Keyframes” in the Help.

Adjusting the Depth between Stereoscopic 
Transitions

It is important to ensure depth continuity from one shot to the next. Objects need to be kept at the 
same relative distance from the screen plane so that they don’t inappropriately jump in and out of 
the scene. For the viewer, this can be particularly discomforting during fast-paced action scenes 
with numerous cuts.

To enter the S3D Settings for the project:

1. From the Project window, select the Settings tab.

2. Double-click S3D Settings.

The S3D Settings dialog displays. Enter the necessary parameters as described in “Setting 
the Depth Budget and Stereoscopic Dimensions” on page 76.

To apply the depth transition:

1. Select the transition point between two clips on the timeline.

2. From the Tools menu, select Effect Palette.

Option Description

Drop-down selection:

Symmetric Allows you to adjust both eyes equally.

Lock Left Eye Locks the left eye while you adjust the right eye.

Lock Right Eye Locks the right eye while you adjust the left eye.

Vergence Move the slider right or left to reposition the 
image horizontally.

Auto-Zoom Automatically zooms in to proportionally scale 
the image and crop out the black areas. Deselect 
this option if you prefer to perform this 
manually.

Zoom Move the slider left or right to manually scale 
the image to crop out the black areas.
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n The Depth Transition is also available in the Quick Transition dialog box.

3. From the left side of the Effect Palette window, select S3D.

A list of stereoscopic effects is displayed on the right.

4. Drag the Depth Transition effect to a cut point on the timeline.

A transition icon displays on the timeline.

5. Select the Depth Transition icon and select Tools > Effect Editor.

6. Set the S3D View Mode in the Record monitor to Difference. 

This displays a blend of both the left and right eyes, and highlights the difference in depth 
with dark grey pixels.

7. Adjust the vergence of the outgoing shot with the ‘A-Side’ slider, setting it to a neutral 
parallax. This will be the new convergence point at the cut.

n Refer to “Adjusting the Convergence Point of Stereo Images” on page 92 for more information 
on parallax and how it affects depth perception.

8. Similarly, adjust the vergence of the incoming shot with the ‘B-Side’ slider to match the 
same neutral parallax. At the cut, this will be the new convergence point of the incoming 
shot.

The vergence will automatically animate between the two clips. The outgoing clip animates 
from the original convergence point at the beginning of the transition to the new neutral 
position at the cut point. The incoming clip animates from the modified convergence point to 
the original convergence point at the end of the transition.

This will automatically animate the gradual refocusing of the depth from one frame to the 
next.
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9. Advance frame by frame through the transition to make sure that the depth velocity isn’t too 
quick and noticeable.

If it is, then adjust the A- or B-side sliders accordingly.

10. You may also need to adjust the duration of the transition.

The amount that you can move the vergence sliders is limited to the length of the transition. 
You may have to add or remove frames on your clips to allow enough time for the depth to 
refocus.

11. You can also apply a Dissolve to blend the video images on the outgoing frames with the 
incoming frames. The Dissolve slider allows you to set the dissolve duration to a percentage 
of the transition duration.

S3D Depth Transition Editor Reference

The S3D Depth Transition effect contains alignment tools to allow you to maintain the depth as 
you make a transition from one shot to the next. The 3D depth of the focal object in the outgoing 
clip should be kept similar to the depth of the focal object in the incoming clip.

You can set keyframes at certain points in time to animate the changes to each image—see 
“Manipulating Advanced Keyframes” in the Help.

Cropping Out Unwanted Areas in Stereoscopic Clips

The Floating Window effect is useful if you want to remove edge violations or reframe an image. 
This effect is specifically for stereoscopic clips as it allows you to view both eyes and make the 
changes to one or both eyes simultaneously. 

Option Description

A-Side Vergence Adjust the vergence between the left and right 
images in the outgoing clip.

B-Side Vergence Adjust the vergence between the left and right 
images in the incoming clip.

The application will animate the vergence as the outgoing clip transitions to 
the incoming clip. The depth range will gradually refocus over the span of the 
duration.

Dissolve Applies a dissolve on the images themselves. 
This blends the outgoing frames with the 
incoming frames over time.
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To crop out unwanted areas:

1. Select the appropriate clip on the timeline, and set your record monitor mode to a side by 
side view.

2. From the Tools menu, select Effect Palette.

3. From the left side of the Effect Palette window, select S3D.

A list of stereoscopic effects is displayed on the right.

4. Select the S3D Floating Window effect.

The effect is applied to the selected stereoscopic clip on the timeline.

n Other effects such as the Spatial Alignment effect also have these controls.

5. Select Tools > Effect Editor to display the Floating Window effect editor.

For parameter descriptions, see “S3D Floating Window Effect Editor Reference” on 
page 99.

6. Adjust the controls as necessary.

S3D Floating Window Effect Editor Reference

The S3D Floating Window effect contains controls to remove edge violations or to reframe an 
image. This effect is specifically for stereoscopic clips as it allows you to view both eyes and 
make the changes to one or both eyes simultaneously.
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You can set keyframes at certain points in time to animate the changes to each image—see 
“Manipulating Advanced Keyframes” in the online Help.

Fixing the Spatial Alignment on Stereoscopic Clips

Use the S3D Spatial Alignment effect if there are any vertical or rotational alignments that need 
to be done on the right and left eyes. This effect also includes tools to crop out edge violations or 
adjust horizontal disparity between the two eyes. 

This effect can be applied either on the source clips in the bin, or on clips that are on the timeline. 
For more information on applying the effect on the source clips, see “Fixing Spatial Alignment 
on Stereoscopic Clips (Source-Side)” on page 79.

Option Description

The following crop controls are available for the left and right eyes:

Symmetric Allows you to crop both eyes equally.

Left Eye Crops the left eye image.

Left Move the slider to crop the left side of the 
image.

Right Move the slider to crop the right side of the 
image.

Right Eye Crops the right eye image.

Left Move the slider to crop the left side of the 
image.

Right Move the slider to crop the right side of the 
image.
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To fix spatial alignment:

1. In the Effect Editor, expand the S3D Spatial Alignment group to view the parameters that 
allow you to adjust the images. 

2. Expand the Alignment group and the respective Right and Left eye groups.

3. Select the necessary options under the Alignment group to move, scale, rotate or shear the 
images—see “S3D Spatial Alignment Effect Editor Reference” on page 81.

4. If you need to converge or diverge the two eyes, expand the Vergence group and see 
“Adjusting the Convergence Point of Stereo Images” on page 92.

5. If you need to crop the two eyes—see “Cropping Out Unwanted Areas in Stereoscopic 
Clips” on page 98.

6. Moving the images may result in black areas appearing around the edges. You can expand 
the Zoom group and select the Auto-Zoom option which scales the images to crop out the 
black areas.

You can also use the Zoom slider to manually scale the image.
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Adding Titles to Stereoscopic Segments

Titles or other graphic objects applied in a stereoscopic project have controls built into their 
effect editors to allow you to create 3D effects that emerge from the screen plane. 

n Titles for stereoscopic projects must be created in the Avid editing application. You cannot 
import them from 3rd-party applications.

To create a stereoscopic title:

1. Move the position indicator to the appropriate location on a clip.

2. Select Clip > New Title or Tools > Title Tool, and select either Marquee or the Title Tool.

3. Enter your Title and save it.

This automatically creates a new clip with an alpha channel in your bin.

4. Drag the title clip from the bin over a segment on the timeline where you want to apply it.

The title effect is attached to the leading eye clip.

5. Open the Effect Editor.

The title is automatically applied to both eyes.
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6. Move the Vergence slider to adjust the distance between the two eyes and create a title that 
appears in front or behind the screen plane. Keep the distance between the left and right 
images at a realistic point so that the resulting image can be interpreted correctly and 
comfortably by the human eye.

7. You can also promote this title to a 3D effect by clicking the 3D Promote button. This will 
give you additional features like 3D borders, drop shadow, page curls, smooth curve 
movement, and rotation.
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11 Outputting Stereoscopic Projects 

You can output a stereoscopic sequence to a baseband device (such as a tape deck or disc 
recorder), or you can export the sequence to a file format such as QuickTime.

You can also export your sequence to another system for finishing. Avid editing applications can 
export an AAF, ALE, or EDL file that contains the editing information (metadata) for the 
selected sequence, along with the video and audio media files for the master clips within the 
sequence.

Outputting Stereoscopic Sequences to a Baseband 
Device

Since you can output stereoscopic sequences in full frame or frame compatible format, you 
should ensure that the proper format has been selected for output. Frame compatible format 
requires a single output stream, whereas full frame requires dual-stream output. The full frame 
output capability will depend on your hardware input/output device—see “Hardware Support for 
Standard and Stereoscopic Media” on page 113. (You may currently only output to tape in a 
single pass.)

By default, the application will use the format specified by the stereoscopic project format. The 
Video Output tool also has various options to allow output of monoscopic, frame compatible, 
and full frame formats. This option can be set independently of your Project format—see 
“Viewing Stereoscopic Material on a Avid Nitris System” on page 70.

When outputting stereoscopic sequences to a baseband device, follow the same procedures as 
you would for standard sequences—see ”Generating Output” in the Media Composer help.

Exporting Stereoscopic Sequences to Media Files

The media formats for which you can output stereoscopic media include the 
following—QuickTime (MOV, AVI), Windows Media (WMV), MPEG, HDV, DV Stream, 
single-frame graphics (PNG, TIFF, BMP, etc.).
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When you export a full frame stereoscopic sequence, separate media files are created for the left 
and right eyes. If you export a frame compatible sequence, then one media file is created with 
both the left and right eyes. Refer to the table below for more specific details:

Before you output your sequence, refer to “Preparing to Export a Sequence” in the Help for your 
editing application. 

Stereoscopic 
Format Description Resulting filenames

Full Full frame format that uses both the left and 
right eye images in full resolution.

If you have any standard (non-stereo) material 
in the sequence, it will use the same image for 
both the left and right eye.

Files are created for each 
eye, one with _L and the 
other with _R, for the media 
format that you want to 
output.

filename_L.mediaformat

filename_R.mediaformat

Side by Side Frame compatible format that uses the left and 
right eye images one beside the other using 
horizontal half res for each eye.

If you have any standard (non-stereo) material 
in the sequence, it will use the same image in 
both the left and right frames.

A single file is created and 
appended with _SS, for the 
media format that you want 
to output.

filename_SS.mediaformat

Over/Under Frame compatible format that uses the left and 
right eye images one over the other using 
vertical half res for each eye.

If you have any standard (non-stereo) material 
in the sequence, it will use the same image in 
both the top and bottom frames.

A single file is created and 
appended with _OU, for the 
media format that you want 
to output.

filename_OU.mediaformat

Leading eye, 
Left eye only, 
Right eye only.

Uses only the image from the specified eye. A single file is created for the 
media format that you want 
to output.

filename.mediaformat
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To select the section for export:

1. Identify the portion of the sequence that you want to export.

n For information on setting options in the Export Settings dialog box, see the Help.

2. Select the clip or sequence by doing one of the following:

t Click the monitor that displays the clip or sequence you want to export.

t Click the clip or sequence in a bin. Ctrl+click (Windows) or Shift+click (Macintosh) to 
select multiple clips or sequences.

3. Do one of the following:

t Select File > Export.

t Right-click the clip or sequence, and then select Export.

The Export As dialog box opens with a default file name in the File name text box 
(Windows) or the Save As text box (Macintosh), based on the file type.

4. Click the Export Setting menu, and select one of the predetermined settings. 

This menu lists the possible formats in which you can export your selection. It also 
determines the type of file(s) that will be exported. For example, if you select Sorenson 
Squeeze, then a QuickTime reference file will be exported. 

Here are the possible options when exporting to media files:

Option Description

To export specific 
tracks in a clip or 
sequence:

Enable the tracks in the Track Selector panel, and disable all others.

Ensure that Use Enabled Tracks is selected in the Export Settings 
dialog box.

To export a 
single-frame graphic:

Mark an IN point to export the marked frame from a bin or a monitor, 
or move the position indicator to the frame you want to export.

Ensure that Use Marks is selected and that Sequential Files is 
deselected in the Export Settings dialog box.

To export part of a 
clip or sequence:

Mark IN and OUT points to export the marked range from a bin or a 
monitor. If you mark an IN point and no OUT point, your Avid 
editing application exports from the IN point to the end of the clip or 
sequence.

Ensure that Use Marks is selected in the Export Settings dialog box.

To export the entire 
clip or sequence:

Make sure the topmost track is monitored.

Ensure that Use Enabled Tracks and Use Marks are deselected in the 
Export Settings dialog box.
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n If none of these meet your needs, then select Untitled and click Options to create a customized 
export setting.

5. If you want to view or modify the current Export Setting, click Options.

The Export Settings dialog box opens. 

The export settings for some formats can be complicated. In some cases, options in the 
Export Settings dialog box open additional dialog boxes with further options. If you are 
modifying the Export settings, consult “Common Export Settings” in the Help.

Close the Export Settings dialog box to return to the Export As dialog box.

6. Select the destination folder for the file.

7. Enter a Filename for the selection that will be exported. 

The extension will depend on the Export Setting that you chose.

8. Click Save.

Export Setting Export Format

Avid 3D Audio WAV

Avid Pro Tools LE (Mbox-Ref) MOV

Fast-Export QuickTime NTSC MOV

Fast-Export QuickTime PAL MOV

Macintosh Image NTSC TIF

Macintosh Image PAL TIF

Make New - QuickTime Reference MOV

Pro Tools QuickTime (ref) MOV

QuickTime Reference MOV

QuickTime Reference DV Codec MOV

Send to QT Movie MOV

Sorenson Squeeze MOV

Sorenson Squeeze - Encode for DVD MOV

Windows Image NTSC BMP

Windows Image PAL BMP
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Your Avid editing application exports the file.

If you abort the Export while it is in progress, any files that were created, will be deleted.

Exporting Sequences via AAF or EDL

If additional finishing is required, then you can send the sequence metadata (AAF/EDL) to a 
stereoscopic 3D-capable finishing system. Your Avid editing application allows you to export 
part, or all your sequence to a project data file with or without along with the video and audio 
media files for the master clips within the sequence.

To select the section for export:

1. Identify the portion that you want to export.

n For information on setting options in the Export Settings dialog box, see the Help.

2. Select the clip or sequence by doing one of the following:

t Click the monitor that displays the clip or sequence you want to export.

t Click the clip or sequence in a bin. Ctrl+click (Windows) or Shift+click (Macintosh) to 
select multiple clips or sequences.

3. Do one of the following:

Option Description

To export specific 
tracks in a clip or 
sequence:

Enable the tracks in the Track Selector panel, and disable all others.

Ensure that Use Enabled Tracks is selected in the Export Settings 
dialog box.

To export a 
single-frame graphic:

Mark an IN point to export the marked frame from a bin or a monitor, 
or move the position indicator to the frame you want to export.

Ensure that Use Marks is selected and that Sequential Files is 
deselected in the Export Settings dialog box.

To export part of a 
clip or sequence:

Mark IN and OUT points to export the marked range from a bin or a 
monitor. If you mark an IN point and no OUT point, your Avid 
editing application exports from the IN point to the end of the clip or 
sequence.

Ensure that Use Marks is selected in the Export Settings dialog box.

To export the entire 
clip or sequence:

Make sure the topmost track is monitored.

Ensure that Use Enabled Tracks and Use Marks are deselected in the 
Export Settings dialog box.
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t Select File > Export.

t Right-click the clip or sequence, and then select Export.

The Export As dialog box opens with a default file name in the File name text box 
(Windows) or the Save As text box (Macintosh), based on the file type.

4. Click the Export Setting menu, and select one of the predetermined settings. 

This menu lists the possible formats in which you can export your selection. It also 
determines the type of file(s) that will be exported. For example, if you select Export to Pro 
Tools, then an AAF metadata file will be exported. 

Here are the possible options:

n If none of these meet your needs, then select Untitled and click Options to create a customized 
export setting.

5. If you want to view or modify the current Export Setting, click Options.

The Export Settings dialog box opens. 

The export settings for some formats can be complicated. In some cases, options in the 
Export Settings dialog box open additional dialog boxes with further options. If you are 
modifying the Export settings, consult “Common Export Settings” in the Help.

Export Setting Export Format

AudioVision AAF

Avid 3D Video AAF

Avid Pro Tools LE (002) AAF

Avid Pro Tools LE (Mbox-AAF) AAF

Avid DS AFE

Consolidate Audio to Folder AAF

Consolidate-Embed Audio Only OMF

Consolidate-Link Audio and Video AAF

Export to Pro Tools AAF

Link to Audio Only AAF

Link to Audio and Video AAF

Link to Audio and Video Mixdown AAF
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Close the Export Settings dialog box to return to the Export As dialog box.

6. Select the destination folder for the file.

7. Enter a Filename for the selection that will be exported. 

The extension will depend on the Export Setting that you chose.

8. Click Save.

Your Avid editing application exports the file.

If you abort the Export while it is in progress, any files that were created, will be deleted.
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12 Hardware Support for Standard and 
Stereoscopic Media

Avid editing applications provide you with a range of resolutions, both compressed and 
uncompressed, that you can use at various stages of your project.

Depending on the capabilities of your system, your Avid editing applications let you 
capture/import, play, edit, render, transcode, export to file, or output with real-time 
uncompressed (1:1) HD standard and stereoscopic media. Depending on your Avid input/output 
hardware, you can have either single or dual-stream input or output.

To get realtime playback of full frame media from shared storage, you will require a 10GB 
ethernet connection. For a list of performance expectations, refer to the Readme document for 
your Avid editing application.

The following table covers all possible Avid configurations that allow editing of 
compressed/uncompressed HD standard and stereoscopic media. The main differences are in the 
capture and output capabilities as shown below:

Configuration Media
Baseband 
Capture Output

Software-only Standard N/A N/A

Stereoscopic: Frame compatible N/A N/A

Stereoscopic: Full frame N/A N/A

Mojo DX Standard Yes Yes

Stereoscopic: Frame compatible Yes Yes

Stereo: Full frame (two-pass) Yes Not applicable

Stereo: Full frame (single-pass) No No

Nitris DX Standard Yes Yes

Stereoscopic: Frame compatible Yes Yes

Stereo: Full frame (two-pass) Yes Not applicable
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Stereo: Full frame (single-pass) Uncompressed 
only

Yes

3rd Party 
Hardware I/O 
support through 
Open I/O

Standard Yes Yes

Stereoscopic: Frame compatible Yes Yes

Stereoscopic: Full frame (two-pass) Yes No

Stereoscopic: Full frame (single-pass) No No

Configuration Media
Baseband 
Capture Output
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